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Basic Requirements 

●     MacLux Pro™ v2.1 requires a Power Macintosh computer. 
●     To install from CD, the computer must be equipped with a CD drive. 
●     MacLux Pro™ takes up approximately 10mb of hard disk space. 
●     MacLux Pro™ requires you to have at least 10mb of RAM available in order to have 

enough memory to run. 

Operating System Requirements

●     MacLux Pro™ v2.1 requires OS 8.6 or later. 
●     MacLux Pro™ v2.1 will run directly under OS-X. It has been tested with versions up 

to 10.3 "Panther" 
●     MacLux Pro™ prefers OS 9.2. 
●     MacLux Pro™ requires the carbon library. This is built into OS-X 1.x. OS 8 and 9 

require that the CarbonLib be present in your extensions folder in order for MacLux 
Pro™ to run. 
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Installing MacLux Pro™ 

 To install MacLux Pro™ onto your Power Macintosh, insert the 
MacLux Pro™ CD into the computer's drive.

If you are unsure about the compatability of MacLux Pro™ with your computer, check 
the installation requirements.

❍     Double-click the MacLux Pro™ v2.1 Installer. 
❍     When the MacLux Pro™ splash screen appears, click the 

Continue button. 
❍     The installer will display the latest information about the 

installation process. 
❍     Read this information. 

 This information will alert you to any changes in the installation 
procedure or requirements.

❍     When you are finished, click the Continue button. 
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 Next, the installer will display the software license agreement.
❍     When you install MacLux Pro™, you must agree to the terms 

of this license. 
❍     If you do not agree, do not install MacLux Pro™ and return 

the software package. 

 If you agree to the software license agreement, click the Agree 
button to continue with the installation. 
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 Next, the installation screen lets you pick the MacLux Pro™ 
package you wish to install.

 The standard installation includes example files.

 You can also choose to install only the application package.

 Next, the installer will ask you where to put the 
items to be installed.

❍     Click the Install button once you've decided on the location. 
❍     The installer will place the MacLux Pro™ files onto your 

hard disk. 
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 Once the installer is finished, you will be asked if you want to 
perform further installations or Quit.

 Double-click the MacLux Pro™ icon to start the application for 
the first time.

❍     You will be asked to personalize your copy of MacLux 
Pro™. 

❍     You are required to enter your serial number and software 
key. 

❍     These will be included in your MacLux Pro™ package. 

If you are upgrading from a previous version of MacLux Pro™, you can obtain a software 
key by e-mailing your serial number to keyrequest@macluxpro.com. You can find your serial 
number on your MacLux Pro™ version 1.7 or later startup screen or by selecting About 
MacLux Pro from the Apple menu.

mailto:keyrequest@macluxpro.com
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Troubleshooting MacLux Pro™ 

Common Problems:

●     Can't start MacLux Pro™ because a shared library cannot be found. 
●     MacLux Pro™ crashes on start up. 
●     MacLux Pro™ runs out of memory (error -108). 

Other problems and solutions are posted at http://www.macluxpro.com as they are discovered. 
For example, versions of OS-X newer than Panther may cause problems that are not yet 
known.

Can't start MacLux Pro™ because a shared library cannot be found.

Either your Power Mac has older system software or some of the components of the system 
have been corrupted or are not available. Check the requirements to see if your operating 
system is compatible with MacLux Pro™. You may need to re-install your system software.

MacLux Pro™ crashes on startup.

The two most common problems that cause MacLux Pro™ to crash when it tries to start up 
are lack of memory and/or a conflict with an extension in your system. MacLux Pro™ 
reserves memory for graphics operations based on the size of your monitor(s). It is possible 
that you may need to increase the amount of memory allotted to MacLux Pro™. See the 
instructions for running out of memory to find out how to do this. Another possibility is that 
there is some extension in your system that interferes with MacLux Pro™. To eliminate this 
possibility, restart your Power Macintosh holding down the shift key. This disables all 
extensions. If this fixes the problem, then you must search for the offending extension by 
using the Extensions Manager control panel. Try going back to a minimal set for your system 
software and adding them back until you find the one that causes MacLux Pro™ to crash.

MacLux Pro™ runs out of memory (error -108)

MacLux Pro™ v2.1 requires an absolute minimum 5mb of RAM to run. It prefers to have 
10mb available. Depending on the configuration of your computer and if you import large 
graphics into your plots, MacLux Pro™ may run out of memory. To solve this problem, with 
OS 8 or 9 you'll need to increase the amount of memory available to MacLux Pro™. With OS-
X you will need to quit other applications to free up more memory for MacLux Pro™.

If you are running many applications and/or there is limited RAM installed in your computer, 
MacLux Pro™ may not be allowed to have the full 10mbs it requests when it starts up. If this 
is the case, you may need to increase the minimum memory setting to get it to run on your 
computer. Otherwise, if you are running out of memory, you will want to increase the 
preferred memory setting. The following instructions tell you how to do this. (OS 8 or 9 only)

http://www.macluxpro.com/
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 To increase the memory available to MacLux Pro™ with OS 8 or 9, 

Select the MacLux Pro™ application in the Finder.

●     Choose Memory from Get Info under the File menu. 
●     If there's no sub-menu, just choose Get Info. 

 Increase the preferred size.

❍     Try 15000 K to begin with. 
❍     If necessary, also increase the minimum memory setting. 
❍     Close the info window. 
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Introducing MacLux Pro™ 

This introductory tour will show you how to use MacLux Pro™’s tools. It will also explain some 
basic concepts that are important for understanding how MacLux Pro™ works. Look for the Mac-

at-the-Drafting-Table icon, , and follow the directions.

 To start the tour, double-click the MacLux Pro™ icon: 

When you start MacLux Pro™ for the first time, both the Tools and Lights palettes are visible. 
After that, the palettes will be how you left them last. If this is the very first time you've used 
MacLux Pro™ you will need to enter your name, serial number and software key. You should see 
a new, blank light plot named “Untitled 1.” MacLux Pro™ makes this plot the same size as 
one page on your printer. If your window is small, you may not have a printer selected with the 
Chooser. You can select a printer with the Chooser and start over or make your plot larger with 
the Document Size command.

 If the Tools palette is not visible, select Show Tools from the Windows Menu.

Even though we haven't yet created a place to place to hang them, let's look at how you draw light 
symbols with MacLux Pro™.

 To draw a light, select the Draw tool: 

❍     The cursor will turn into a pencil. 
❍     When you press the mouse, a light symbol will appear. 
❍     You can move the light around until you release the mouse. 
❍     The symbol that is drawn is selected by the Lights palette. 
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If the Lights palette is not visible, select Show Lights from the Windows Menu. 
❍     Try drawing a few light symbols. 

You might have noticed that all the symbols point towards the top of the screen. Use the 
arrow keys to select a direction before you draw a light. Once a direction is selected, all 
symbols will be drawn pointing that direction (or 45° clockwise of it) until another arrow key 
is pressed. It is not necessary to hold the arrow key down as you draw. However, holding 
down the shift key as you press the mouse, rotates a symbol 45° clockwise of the direction 
selected.

 Try using the arrow keys to change the direction of a few symbols.

❍     Hold down the shift key and draw a symbol. 

To change a symbol after it has been drawn, select it with the Arrow tool: 

❍     To select a single symbol, click on it. 
❍     To select several symbols, hold the mouse button down and drag. All the 

symbols within the gray rectangle will be selected. 
❍     Using the shift key, you can add and remove symbols from the current 

selection. 
❍     You can also use the Arrow tool to move symbols around the screen. 

When a light is selected, choosing a new symbol from the Lights palette will change the 
selected symbol. Likewise, pressing an arrow (or arrow and shift) key will change the 
direction of the selected symbols. You can also use the Rotate command from the Selection 
menu to rotate the selected symbols in 45° steps.

Lights in MacLux Pro™ are not just graphic symbols. They are also objects which can have 
data attached to them. You can assign them a circuit, dimmer, channel, color, etc.

 Using the Arrow tool, double-click on one of the lights you've drawn.

❍     You can also select a light and choose the Info command from the Selection 
menu. 
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Enter the following information in the dialog: 

After you click OK, your light might look like this: 

Some of the fields of data associated with a light may be drawn next to its symbol. In the 
above example, you see the color and channel fields. You select which fields to draw by 
clicking the Drawing button. Although you can reposition the text with the Arrow tool, it 
will always stay in the same relationship to the symbol when the symbol itself is moved.

If you are not sure of the use of the different fields of information, see Using the Light Info.

When Auto-Color is selected in the Preferences, MacLux Pro™ looks in its library of 
colors each time you close the info dialog. R80 in the library is blue, so MacLux Pro™ colors 
the light symbol accordingly. (Note: the color found in the library is R80 not r80 or x80. You 
can, however, edit the names in the library.)

Note: Accessories, such as barn doors and top hats do not have a color, channel, etc. If you 
double click an accessory symbol, MacLux Pro™ just beeps.

Each type of light symbol also has information about what it represents, its wattage, beam 
spread, etc. MacLux Pro™ uses this data to produce PaperWork reports, calculate the beams 
of lights, and to display the key block which appears on the plot.
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Double click a symbol on the Lights palette. 
❍     Or, select a symbol and use the Key command from the Setup menu. 

The key dialog allows you to edit the name of the symbol. You can also tell MacLux Pro™ 
how many of this type of light that you have available. (This will show in the Equipment List 
report.) You can edit additional information about the symbol by clicking the Detail 
button. You can also view and change the Symbol. To quickly assign an instrument type to a 
symbol, you can use the key library.

 Click the Key Library button in the key dialog.

 Select 36 degree Source Four from the list by clicking on it.

❍     Click the Use button. 
❍     Click the Done button to close the library. 

The symbol you selected in the lights palette is now changed to represent a 36 degree Source 
Four. You should notice that the symbol itself in the lights palette changed. You can associate 
a symbol with a key library entry so that when you use that entry, the symbol will always be 
assigned as well.
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Now that you know how to access information for lights and symbols, lets go back and look 
at how to create a place to hang your lights. In MacLux Pro™, hanging positions are 
represented with lines. 

 To draw a hanging position, select the Line tool: 

❍     The cursor will turn into a +. 
❍     Select 2 Pixels from the Lines Menu. 
❍     Press the mouse at the point you want the line to start. 
❍     Drag to where you want the line to end and release the mouse. 
❍     Try drawing several hanging position lines. 

The Line tool also lets you draw graphic lines including dashed lines and dimension lines. 
However, only position lines can interact with light symbols. The type and width of the line 
you draw is selected with the Lines menu. Although these objects appear to be just normal 
“lines,” they are more than just a line on the screen. Lines in MacLux Pro™, including 
dashed and dimension lines, are objects that have data attached to them just like light 
symbols.

 Using the Arrow tool, double-click on one of the lines you've drawn.

❍     Double clicking is the same as selecting a line and choosing the Info command 
from the Selection menu. 

❍     You can select a line by clicking on it or by dragging the Arrow tool so that the 
gray rectangle intersects or encloses the line when the mouse is released. 

Like a light, a position can display some of its information fields. If you entered the 
information shown in the example dialog (and checked the Draw boxes), the position might 
look like this:

You can move the text around but it stays with the position if you move the entire line.
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While all lines, including dashed and dimension lines, have the same information attached, 
only position lines can interact with their intersecting lights. MacLux Pro™ assumes that 
when a light symbol intersects a position line, the light is “hanging” on that position. If a 
symbol intersects more than one position line, it will attach itself to the one that is first in the 
Positions list. The Positions window lets you select a position and use the plus (+) and minus(-
) keys to move it up and down in the list. 

Position lines have options for automatically numbering lights that are hanging on them. The 
Don't Number option is useful if you've hand numbered a position for some reason and 
don't want to accidentally renumber it. By default, alignment and dimensioning are calculated 
from a positions’ center point. Layout From End, causes these options to use the line's 
end point instead.

Here are some more tips about working with lines:

❍     To change a line after it has been drawn, use the Arrow tool. 
❍     To move a line, click on it and drag it to a new location. 
❍     To reshape the line, click near the end you want to move and drag it. 
❍     If you have difficulty grabbing the end of a line, select the line first. 
❍     Once a line is selected, the target areas at the ends of the line are larger. 
❍     To change the width of a line, select it . Then choose a new width from the 

Lines menu. 

You might have noticed that there is one more tool we haven't covered in this section, the 

Hand tool: . The use of the hand tool is explained in the third chapter, Beams and Cues.
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Getting Started 

If you were sitting down at a drafting board to begin a light plot, chances are that you would 
begin by drawing or tracing a ground plan of the theatre. MacLux Pro™ lets you place a 
PICT under your plot, just as you might lay a sheet of vellum over a scene designer's ground 
plan (PICT is the Macintosh's native graphics format). You can create a PICT with any 
drawing or CAD program. (In the best of all possible worlds, the scene designer uses a Mac 
and gives you a disk with the ground plan on it!)

MacLux Pro™ actually has up to 6 independent PICT layers that you can use under the plot. 
They can be shown/hidden in any combination. A control window for each layer lets you 
Open, Cut, Copy, Paste and Clear a PICT Layer, as well as move it around the plot.

MacLux Pro™ comes with some generic PICT files showing a proscenium, plaster line and 
center line. They are meant as a starting place that you can adapt to your taste and your 
theatre. To keep things simple, we will use the smallest one for this demonstration.

 If you are just starting up MacLux Pro™, it opens a blank plot for you.

❍     Otherwise, choose New from the File menu. 
❍     To place a PICT in your plot, choose the first Available layer from the 

PICT Layers menu (under Edit). 
❍     The Layer's control window will appear. You can move the window by 

dragging its title bar or move or close the lights palette if needed. 
❍     Click the Import button and find the file: 16' Prosc. (Look in the Plots 

folder, then inside the Tour folder, to find it). 
❍     Use the Change Name button to name the Layer, "Ground Plan" 
❍     Close the control window by clicking the close box or choosing Close from the 

File menu. 

Hints: A PICT Layer can be hidden or shown by holding down the option key and selecting it 
from the PICT Layers menu. You can also drag a PICT file to the MacLux Pro™ icon and 
drop it. This creates a new plot the same size as the PICT. And it places the PICT file into the 
first PICT layer.

 To set the size of the plot, use the Document Size command in the File menu.

❍     The radio buttons let you see the current size in pages, inches (24x36 etc.) and 
pixels. 

❍     When you click OK, the document's size is set in the currently displayed units. 
For now, make it 1 page by 1 page. 

❍     (To make the plot the same size as the ground plan, click the PICT Size button. 
). 

MacLux Pro™’s native scale is 1/4” (1:50). From this scale, you can print the plot at 50% or 
200% to get 1/8” or 1/2”output. You can also zoom in and out to see the plot at different 
sizes. When beginning a plot, it is a good idea to consider how you will be printing it and set 
the Document Size accordingly. Hint: Printing at 50% on a laser printer and then blowing a 
plot up at a copy center works quite well.
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The next step in working with a traditional light plot would be to determine what symbols 
you want to use from your plastic template. Similarly, you will want to set up the lights 
palette and the key that defines what type of light a symbol represents: 

 If the Lights palette is not visible, select Show Lights from the Windows menu.

❍     Let's assume that we want the basic USITT 6x9 symbol to represent a Strand 
#2209. 

❍     If its not already selected, click on the 6x9 symbol. 

 Choose Key Library from the Setup menu.

❍     Scroll down the list and find “Strand 6x9 #2209.” 
❍     A quick way to do this is to click the Find button and enter "6x9." 
❍     Click the Again button to find the next entry for 6x9, this should be the 

#2209. 
❍     Click the Use button. 
❍     You can continue to define symbols in the palette. 
❍     Click on the 6" fresnel symbol. 
❍     Use the above process to make it an Altman 6" fres (#65Q). 
❍     Note that the find feature is case sensitive. 

You can also use the Key command to tell MacLux Pro™ how many of each type of light you 
have in your inventory. The Equipment List will keep track of how many you've used and 
how many you have left.

The lights palette is customizable using the Symbol command. You can select a set of 
symbols that is stored with your plot. Some key library entries also have symbols assigned to 
them.

 Select the symbol in the upper left corner of the lights palette.

❍     Use the key library to make it a Source Four 36 degree. 
❍     Close the key library window. 
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Now that we have a theatre, its time to draw some places to hang lights. If you were drafting 
on paper, you would have to erase the position line every time you drew a light. But, with 
MacLux Pro™, you don't have to worry because it automatically draws the lights in front of 
the lines and the background. MacLux Pro™ also has several commands that make laying out 
the plot faster and easier. 

 Select Show Info Bar at the bottom of the Display menu.

❍     This shows you the location of the cursor in scale coordinates. 
❍     Use the Grid (Show Grid from the Display menu) to assist laying out the plot. 
❍     You can set the center point of the drawing using the Line tool. 
❍     If the Tools palette is not visible, select Show Tools from the Windows menu. 
❍     Select the Line tool from the Tools palette. 
❍     Place the cursor over the center of the stage at the proscenium line, hold both 

the command and option keys down, and click the mouse. 

 Choose 2 Pixels from the Lines menu.

❍     This sets the width of the position lines that will be drawn. 
❍     Using the Line tool, start 7'-0" DS (downstage) of the proscenium and 10'-0" 

SR (stage right) of the center 
❍     Draw to 7'-0" DS and 10'-0" SL. (stage left) This will be the front of house 

position. 
❍     Switch to the Arrow tool and double-click on the line you've just drawn. 
❍     Label it "FOH" and click the Draw box next to the name. 
❍     Change the Height to 15ft and click OK. 
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To make things even easier, you can use the option key to force the ends of a line to snap 
to the nearest point on a 6" (50cm) grid, relative to the center point. You must press the 
option key before you click the mouse to align the starting point. You must keep the 
option key down until after you've released the mouse to align the end point. 

 Try using the option key, holding it down as you draw the next position. 
Remember, with the option key, you only need to get close and the line will snap to 
the grid

❍     Draw a position 2ft US (upstage) of the proscenium from 8ft SR to 8ft SL. 
❍     Name it, "1st Electric." 

Now that we have a few places to hang them, its time to start drawing lights. If you want to 
begin here, the plot "tour.1" in the tour folder (inside the plots folder) has all the steps so 
far completed for you. As with drawing lines, the option key causes lights to align 
themselves with a line when they are drawn or moved.

 Choose the Draw tool.

❍     Select the 6" fresnel from the Lights palette. 
❍     Press the down arrow key to select a direction. 
❍     Press the mouse and drag the fresnel near the center of the 1st Electric. 
❍     Before you release the mouse, press the option key. 
❍     As you let up on the button, be sure to keep the key down until the pencil 

cursor reappears. 
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The fresnel should have jumped directly to the center of the position. Options for how lights 
will align themselves are found under Alignment in the Controls menu. 

 Draw 2 more fresnels, 4ft stage right and 4ft stage left of center.

In the following example, the shift key is combined with the option key to align the light and 
rotate it 45°.

 Press the up arrow key.

❍     Choose a 6x9 from the lights menu. 
❍     Hold both the shift and option keys down and press the mouse. 
❍     Drag the 6x9 to around 9ft SR of the center of the FOH position. 
❍     Release the mouse. (Keep the option key down until the cursor appears.) 

There are more ways to lay things out quickly.

 Using the Arrow tool, select the 6x9 you just drew.

❍     Choose Duplicate from the Selection menu. 
❍     Enter 3ft 0in for the spacing. 
❍     Push the "E" button to indicate the copies will be made to the right. 
❍     Enter 2 for the number of copies and click OK. 
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 Hold down the shift key and click on the original 6x9 to select it.

❍     All three 6x9s should now be selected. 
❍     Choose R&R from the Selection menu. 
❍     This will repeat in reverse the selected lights with respect to the position's 

center. 
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We now have the skeleton of a very basic light plot. The next step is attaching information to 
the light symbols. MacLux Pro™ has many tools to automate this task. If you want to begin 
here, the plot "tour.2" in the tour folder (inside the plots folder) has all the steps so far 
completed for you. 

 Select the FOH position by clicking on the line.

❍     Choose Number Lights from the Selection menu. 
❍     When asked, choose to start with number 1 by clicking OK. 
❍     Repeat for the 1st Electric. 

 Using the Arrow tool, double click on the 6x9, FOH #6.

❍     Enter "R33" in the color field 
❍     Enter "Front Warm" in the group field. 
❍     Click OK. 
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The light's symbol should have changed from black to pink when you finished. Now that 
you've entered information for one light, MacLux Pro™ allows you to "paste" that 
information into other lights. This saves you the task of repetitively entering the same 
information. 

 Select the same light (#6) and choose Copy from the Edit menu.

❍     Choose Paste Options from near the bottom of the Edit menu. 
❍     Make sure that the Color, Symbol Color and Group boxes are checked. 
❍     Click OK 
❍     Now, Select the other two 6x9s on that side (#4 and #5) by holding down the 
shift key while you click on them. 

❍     Choose Paste Info from the Edit menu. 

 Repeat the procedure for the rest of the lights:

❍     Double click the far right 6x9, #1 
❍     Enter "R62" and "Front Cool" and click OK. 
❍     Copy the light and use Paste Info to transfer the color and group to the 

remaining 6x9s. 
❍     Double click the far right 6" fresnel, 1st Electric #1. 
❍     Enter "R54" and "Top" and click OK. 
❍     Copy the light and use Paste Info to transfer the color and group to the 

remaining fresnels. 
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We have quite quickly assigned color and group information to our plot. Now, lets see how 
fast we can assign channels. If you want to begin here, the plot "tour.3" in the tour folder 
(inside the plots folder) has all the steps so far completed for you.

 Hold down the control key (ctrl) and click on the 6x9 just left of center, FOH #4.

❍     You should get a menu to popup. 
❍     Choose Chan... from the menu. 
❍     Note: you can also select the light and push the "c" key on the keyboard. 
❍     Enter 1 and click OK. 
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That was a quick way of entering a channel without having to open the entire light info dialog 
window. But, when you are going to be entering sequential channel numbers, there is a faster 
way. 

 We are going to select some lights, it is important that they are selected in this 
order.

❍     The 6x9 FOH #4 should still be selected. If not, click on it. 
❍     While holding down the shift key, click on FOH #5 
❍     While holding down the shift key, click on FOH #6 
❍     While holding down the shift key, click on FOH #1 
❍     While holding down the shift key, click on FOH #2 
❍     While holding down the shift key, click on FOH #3 
❍     While holding down the shift key, click on 1st Electric #1 
❍     While holding down the shift key, click on 1st Electric #2 
❍     While holding down the shift key, click on 1st Electric #3 

All the lights should now be selected.

❍     Choose Auto-Fill from the Selection menu. 
❍     Because we want to start with channel 1, we are set. Click OK. 

MacLux Pro™ automatically entered channel numbers in the order that the lights were 
selected. You can use the same procedure to enter sequential circuit or channel numbers as 
well.
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Now that the plot is beginning to shape up, lets look at how the drawing is linked to the 
PaperWork. First, however, you might want to enter some title information about the plot. 

 Choose The Show from the Setup menu.

❍     Enter a name for the show, etc. 
❍     MacLux Pro™ should have entered the name the program is registered to as the 

designer. 

Reports, such as the instrument schedule, have their own windows. Reports can be 
customized with the commands in the Setup menu. Reports can be exported by saving them 
as a text file using the Save command when their window is active. If you want to begin here, 
the plot "tour.4" in the tour folder (inside the plots folder) has all the steps so far 
completed for you.

 Choose Instrument Schedule from the Windows menu.

❍     Try double-clicking on one of the lines of text describing a light. 
❍     You can edit objects in all PaperWork reports where a line of text corresponds 

to an object. 
❍     When you select an object in a report, it is selected in the plot window as well. 

 To customize the Instrument Schedule, choose Inst. Schd. Setup from the Reports 
menu (at the bottom of the Setup menu) .

❍     Click on the Lamp field and then click the Delete button. 
❍     Click on the Add button 
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 Select Group from the Field popup menu.

❍     Click OK. 
❍     Select the new Group field from the bottom of the list and click the Up button. 
❍     Click Done. 

The order that the positions appear in the Instrument Schedule is determined by the Positions 
report. Right now the FOH position is first because it was drawn first.

 Select the Positions report from the Windows menu.

❍     Click on the 1st Electric to select it. 
❍     Push the + key on the keyboard. 
❍     This will move the 1st Electric to the top of the list. 
❍     Close the Positions report. 
❍     The Instrument Schedule should have changed so that the 1st Electric now 

comes before the FOH. 

The plot is almost finished. We just need to add a few things like a key and title block. 
Dimension lines showing the spacing of the lights would also be nice. We also should clean 
up the text attached to the center fresnel because it is hard to read with the center line running 
through it. If you want to begin here, the plot "tour.5" in the tour folder (inside the plots 
folder) has all the steps so far completed for you.

 Switch back to the main plot window by closing the Instrument Schedule.

❍     Hold down the command (apple) key and click on the 1st Electric line. 
❍     This is a shortcut to selecting all the lights on a position 
❍     Choose Create Dimensions from the bottom of the Selection menu. 
❍     Choose the Dimensions command from the Controls menu. 
❍     Click the button to have the dimension lines appear beneath the light symbol. 
❍     Click OK 
❍     Command click the FOH line. 
❍     Chose Create Dimensions again. 
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 Using the Arrow tool, select the center 6" fresnel, 1st Electric #2.

❍     Choose Field Drawing from the Selection menu. 
❍     Check the Color and Chan boxes. 
❍     Click the Opaque button. 
❍     Use the arrow tool to reposition the color text away from the front of the light 

symbol. 

The final touch would be to add key and title blocks to the plot. MacLux Pro™ allows you to 
add misc. graphics and text to your plot. These small graphics are called PICT Objects. Two 
of the types of PICT Objects available are automatically generated key and title blocks.

 Choose PICT Objects from the Edit menu.

❍     Click the Add button. 
❍     Select Auto Title Block and click OK. 
❍     You can add notes to your title block using the Notes command under Setup. 
❍     Lets assume that we don't want notes for now. 
❍     The Title Block should be selected in the PICT Objects window. 
❍     Click the Edit button. 
❍     Click the Options button. 
❍     Check the Don't Show Notes box. 
❍     Let's also change the font of the title block. 
❍     Click the Text Style button. 
❍     Choose a new font from the popup menu. 
❍     Click OK in the options dialog. 
❍     Click OK in the edit PICT object dialog. 
❍     Switch back to the main plot window and drag the title block into place using 

the Arrow tool. 
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Choose PICT Objectsfrom the Edit menu or click on the window if it's not behind 
the plot.

●     Click the Add button. 
●     Select Auto Key Block and click OK. 
●     Click the Done button in the PICT Objects window. 
●     Drag the key block into place using the Arrow tool. 

Congratulations, you've just completed your first light plot using MacLux Pro™! It should 
look something like this:

The finished plot is in the file "tour.6".

So far, everything we've done has been an extension of the traditional process of creating a 
plot with pencil and paper. You can see however, that on the computer there are numerous 
tools that speed up the process. In the next section, we'll continue the tour and delve into way 
that the computer can enhance the design process by showing you the beams created by lights 
and even letting you create cues from your light plot.
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Beams & Cues 

Chapter Contents

Introduction to the Hand Tool and Cue Mode
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Using the Console

Setting the Spot/Flood on an Instrument with a Variable Beam

Beam and Illumination Calculations

Show Model

Transferring Cue Info to a Light Board

Using Raytrace Data to Render an Image

Creating an Animation of a Cue 
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Introducing the Hand Tool and Cue Mode 

This section is about MacLux Pro™’s Cue Mode which allows you to create cues using your 
light plot. Cue Mode is designed to let you try out your lighting ideas to see what they might 
look like. This lets you make adjustments to the plot prior to load-in. You can view your cues 
in several ways ranging from representational to photo-realistic. MacLux Pro™ shows you a 
cue in several quick, approximate, interactive ways. But it also lets you export a description 
of the lighting to a raytracing program that can render a high quality image.

You enter Cue Mode by choosing the Hand tool. The Arrow, Draw and Line tools take care 
of the drawing and paperwork part of creating the plot. Cue Mode is different because it is 
designed to let you use the plot to create cues. The shift from making the plot to using it, is 
emphasized by a change in the menu bar. The Selection and Lines menus are replaced with 
the Cue menu.

This section begins where "Creating a Plot" left off. If you want to begin here, open the plot 
"tour.6" in the tour folder (inside the plots folder). First, we'll learn how to focus a 
light.

 If the Tools palette is not visible, select Show Tools from the Windows menu.

❍     Choose the Hand tool. 
❍     Click on a point somewhere upstage left. 
❍     The spot selected with the Hand tool is marked with a small cross. 
❍     This selected spot is used to mark the focus point of a light. 
❍     Hold down the option key and click on the light, FOH #4. 
❍     That light is now focused on the point marked by the cross. 
❍     Release the option key and click on the light again but don't release the 

mouse right away. 
❍     A window should appear that shows the level of that light's channel. 
❍     Drag the mouse to the right to set a level. 
❍     Release the mouse when the channel is at full. 
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The beam should appear in the color of the light symbol. In the case of R33, this is light pink. 
The size of the beam is calculated on the photometric information found in the key. Each 
position has a height attached to it. The combination of this information along with the focus 
point is used by MacLux Pro™ to display the beam. Right now it is showing the pattern of 
the beam on the floor. To properly determine how beams will overlap, it is more useful to 
know what they look like at head height. 

 Choose Floor Plane from the Controls menu

❍     Set the height to 5'-0" 
❍     Notice how the beam display moves closer to the light when you click OK. 

Now let's get busy and focus all the lights. If you want to have it done for you, open the plot 
"tour.7" in the tour folder .

 Choose Beams from the Controls menu.

❍     Uncheck the Colored beams box. 
❍     This will make it easier to see what we are doing. 
❍     You might want to choose Show Grid from the Display menu. 
❍     Click on the point 4'-0" upstage and 4'-6" stage left of center. 
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Hold down the optionkey and click on these lights: 
❍     FOH #1, channel 4. 
❍     FOH #4, channel 1. 
❍     When you click on this light, its beam should jump to the new location. 
❍     1st Electric #1, channel 7. 

 Release the option key and click on the point on the center line and 4'-0" 
upstage.

❍     Hold down the option key and click on these lights: 
❍     FOH #2, channel 5. 
❍     FOH #5, channel 2. 
❍     1st Electric #2, channel 8. 

 Release the option key and click on the point 4'-0" upstage and 4'-6" stage right 
of center.

❍     Hold down the option key and click on these lights: 
❍     FOH #3, channel 6. 
❍     FOH #6, channel 3. 
❍     1st Electric #3, channel 9. 

We have set the focus of all the lights. Now we can turn them on and check how we've done.

 Hold down the command (apple) key.

❍     Click on the light, FOH #4, channel 1 and drag to the right. 
❍     Notice this time that the light's group instead of it's channel is affected. 
❍     Release the mouse when the Front Warm group is at full. 
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You can check the focus of the other groups using this method as well. 
❍     Try turning each group on and off using the command key with the Hand tool. 
❍     Lets start off the next part of the tour with a blackout. 
❍     Choose New Cue from the Cue menu. 
❍     (Add Cue creates a duplicate of the current cue.) 

The hand tool is one way to turn lights on and off in MacLux Pro™. There is also a console 
window that functions much like a light board.

 Choose Console from the Windows menu.

❍     Press the following keys on the keyboard: 
❍     7 
❍     = 
❍     / 
❍     Press enter or return. 
❍     This is the same as saying channel 7 at full. 

The console accepts keyboard commands just like a light board. The syntax is designed to 
take advantage of the numeric keypad on a full sized keyboard. MacLux Pro™ even lets you 
assign them fade times, etc. to your cues.

Before we get into cues, you might have noticed that the beam of the fresnel is on the spot 
rather than flood setting. Let's widen it out a bit.



MacLux Pro™ User Guide

Introducing MacLux Pro™-> Spot / Flood Settings

Closethe console window and select the Arrowtool. 
❍     Select the light 1st Electric #1 by clicking on it. 
❍     Choose Focus from the Selection menu. 
❍     Check the box Show Details so that you can set the focus precisely. 
❍     Move the slider until the BeamSpread is 30 degrees. 
❍     You can also simply type 30 into the Beamspread field. 
❍     Click OK 
❍     Choose the Hand tool again. 

That's better.

MacLux Pro™ can transfer variable beam information with the Paste Info command. This 
allows you to copy the spot/flood setting and apply it to the other fresnels.

 Choose Arrow tool.

❍     Select the fresnel, 1st Electric #1. 
❍     Choose Copy from the Edit menu. 
❍     Choose Paste Options from near the bottom of the Edit menu. 
❍     Click the None button. 
❍     Then, check the Var. Beam box. 
❍     Click OK 
❍     Select the other two fresnels by clicking on them with the shift key held 

down. 
❍     Choose Paste Info from the Edit menu. 
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The BeamSpread command calculates the intensity of the beam of a selected light. Another 
way to see the intensity of the light is with the Point By Point display. 

 Switch back to the Hand tool.

❍     Choose Show Pt by Pt from the Display menu. 

The numbers represent the horizontal foot candles at evenly spaced points. (every 2ft or 1.5m) 
You can also display vertical illumination and luminance. The options for the point by point 
display can be found in the Beams dialog in the Controls menu.

 Choose Hide Pt by Pt from the Display menu.

❍     Choose Show Model from the Windows menu. 
❍     Pick a point inside the beam and select it by clicking with the Hand tool. 
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The Model window shows a 3D model of a simple cylinder shaded by the lights falling on the 
selected point at the floor plane. Use the Hand tool and click around in the beam to see how 
the light changes on the cylinder. 

 Use the Hand tool and click around in the beam to see how the light changes on the 
cylinder.

❍     Use the Hand tool to turn on some front light, either channel 1 or channel 4. 
❍     You can even select a color for the cylinder using the Model Color command 

(in the Color menu under Edit). 

You can enter information about a cue such as when it happens and what it does.

 Choose Cue Info from the Cue menu.

Stepping through the cues is easy using the left and right arrow keys. You can output the cue 
information in several report formats including the Cue Sheet which lists the cues and 
Console Data which puts the cues in a format that can be transferred to a light board. The 
USITT ASCII standard can be translated by a number of off-line editing programs and some 
light boards directly. ETC, for example, has off-line editors for several of its console models. 
They are designed to run under Microsoft Windows. However, Virtual PC allows you to run 
them on a PowerMac. The process of working with ASCII files is very straightforward. This 
is the process for loading cues into Expression Off-Line running under Windows/Virtual PC.

 Open the Console Data window and Save it as a TEXT file.

❍     Run Virtual PC and start Expression Off-Line. 
❍     Choose Read ASCII from the Convert Menu. 

http://www.connectix.com/
http://www.etcconnect.com/html/freesoft.htm
http://www.connectix.com/
http://www.etcconnect.com/html/freesoft.htm
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MacLux Pro™ also generates data from a cue that can be saved in a format that is readable by 
a 3D rendering program. The Raytrace Data report contains lighting information in one of 
several different 3D formats. MacLux Pro™ allows you to combine this lighting information 
with an existing 3D model. You can then Save the resulting file and render it using the 
another application. 

The Persistence of Vision (POV-Ray) raytracing program is a popular application that was 
created cooperatively by a group of people working together online. POV-Ray is available for 
a number of operating systems, including Power Macintosh. It produces remarkable images 
and best of all, POV-Ray can be downloaded from the internet for free. For the next part of 
the tour, you will need to obtain a copy of POV-Ray.

 Open the LightLabPlot inside the LightLab Folder (in the Plots 
folder)

❍     If the Tools palette is not visible, select Show Tools from the Windows menu. 
❍     Select the Hand tool. 
❍     Choose New Cue from the Cue menu. 
❍     Click on the light assigned to channel 62 in the center of the plot. 
❍     Drag the mouse to the right to set channel 62 to full. 
❍     Release the mouse. 
❍     Click on the color changer symbol in front of that light. 
❍     From the popup menu, select a color. 
❍     Click on the light in the lower right corner assigned to channel 181. 
❍     Drag the mouse to the right to set channel 181 to 20%. 

http://www.povray.org/
http://www.povray.org/binaries/index.html
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MacLux Pro™ can combine the lighting information it generates, with an existing 3D model 
file. It searches the model file for a line that reads "//macluxpro". This will be ignored by 
the raytracing program. However, when MacLux Pro™ encounters this line, it will insert its 
lighting information at that point. 

 Choose Raytrace Data from the Windows menu.

❍     When prompted, locate the DancerModel.pov file (in the LightLab Folder). 
❍     Click Open to insert the lighting information into this file. 
❍     The Raytrace Data window now contains a combination of the surface 

information from the model file and the lighting information from MacLux 
Pro™. 

❍     Choose Save from the File menu. 
❍     Click OK to save the raytrace data as Lights&DancerModel.pov. 

 Switch to the Finder.

❍     Locate the Lights&DancerModel.pov file. 
❍     Double-click it to launch POV-Ray. 
❍     Choose Start Rendering from the Render menu. 

You can choose to have POV-Ray render different size images by choosing the Render 
Settings command from the Edit menu.

http://www.povray.org/binaries/index.html
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MacLux Pro™ allows you to create a series of images that can be combined to make an 
animation of the transition from one cue to another. To "film" a cue, MacLux Pro™ breaks 
the action into a number of frames. Each frame consists of a picture of the lighting, part way 
through the cue. Each frame is saved as a separate PICT file. The series of images can them 
be assembled into a QuickTime movie. The number of pictures is dependent on the length of 
the cue and the speed that the movie will play. If the movie plays at 15 frames per second and 
the cue lasts 5 seconds, there will be 75 total frames or image files! 

In order to assemble the series of PICT files into a QuickTime movie, you need some video 
editing software. The simplest and cheapest way to do this is to use the QuickTime Pro 
version of QuickTime Player. You can also use higher end software like Adobe Premier. This 
example will use the Pro version of QuickTime Player.

 Open the plot "qt.example" in the "qt.example folder" in the tour folder.

❍     If the Tools palette is not visible, select Show Tools from the Windows menu. 
❍     Select the Hand tool. 
❍     Choose Zoom Out from the Display menu. 
❍     Choose Film Cue from the Cue Menu. 
❍     Click OK for 15 frames per second. 
❍     Click the Desktop button so that you can easily find the files you are about to 

create. 
❍     Click the New Folder button. 
❍     Name the new folder "My Cue" and click OK. 
❍     Click the Save button. 

MacLux Pro™ will create 75 PICT files that contain the frames of the cue (5 seconds x 15 
frames pre second). These files will be found inside your newly created "My Cue" folder on 
your desktop. They will be named Cue.1 through Cue.75.

 Open the QuickTime Player application.

❍     Remember you need QuickTime Pro for this part. 
❍     Choose Open Image Sequence from the File menu. 
❍     Find the file, cue.1 in your new My Cue folder on your desktop. 
❍     Double-click Cue.1 in the list or select it and click Open. 
❍     Click OK when asked for the frame rate of 15 frames per second. 
❍     When QuickTime Player is done importing, play your movie. 

MacLux Pro™ also lets you save a sequence of Raytrace Data files so that a program like 
POV-Ray can render the individual frames that make up a movie. You will need both the 
QuickTime Pro version of QuickTime Player and to have downloaded POV-Ray for this final 
example.

http://www.apple.com/quicktime/
http://www.apple.com/quicktime/
http://www.apple.com/quicktime/
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You will need both the QuickTime Pro version of QuickTime Player and to have downloaded 
POV-Ray for this final example. 

 Open the plot "qt.example" in the "qt.example folder" in the tour folder.

❍     If the Tools palette is not visible, select Show Tools from the Windows menu. 
❍     Select the Hand tool. 
❍     Choose Raytrace Data from the Windows menu. 
❍     Locate the qtExample.pov file in the "qt.example folder" in the tour folder. 
❍     Click Open. 
❍     Choose Film Cue from the Cue Menu. 
❍     Click OK for 15 frames per second. 

MacLux Pro™ will create 75 .pov files that contain the frames of the cue. These files will be 
found inside the "qt.example" folder. They will be named 0.qtExample.pov through 
75.qtExample.pov.

 Switch to the Finder and open the "qt.example" folder.

❍     Choose Select All from the Edit menu. 
❍     Hold down the shift key. 
❍     Click on the qt.Example plot and the qtExample.pov file to deselect them. 
❍     You should still have all the newly created x.qtExample.pov files selected. 
❍     Choose Open from the Finder's File menu. 

When you do this, POV-Ray should launch and begin rendering. POV-Ray will create a 
series of images, "0.qtExample.pict" through "75.qtExample.pict". This may take a while.

 Quit POV-Ray.

❍     Open the QuickTime Player application. 
❍     Choose Open Image Sequence from the File menu. 
❍     Find the file, 0.qtExample.pict in the qt.Example folder. 
❍     Double-click 0.qtExample.pict in the list or select it and click Open. 
❍     Click OK when asked for the frame rate of 15 frames per second. 
❍     When QuickTime Player is done importing, play your movie. 

http://www.apple.com/quicktime/
http://www.povray.org/
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File menu commands allow you to manipulate disk files. Like most Macintosh® 
applications, MacLux Pro™ uses a document centered approach. In order to do something, 
you must be working on a document, which is stored as a file on a disk. To view or make 
changes to the document, you must get it from disk into the application (Open). Once you're 
done working you must put it back on the disk (Save). While you are working, the document 
is represented on the screen by a window that has the same name as its corresponding disk 
file. 

File menu commands relate to the active (top) window. In the case of MacLux Pro™, the 
central document is a light plot. If the main plot window is the front window, the File menu 
commands refer to the plot file. But, MacLux Pro™ allows you to create sub-documents 
(such as an instrument schedule) which also have their own windows. If one of these 
windows is active, a command such as Print will relate to the window rather than the plot.

New (cmd-N) creates a new light plot document. This plot remains untitled until it is saved 
on disk. When you double click on the MacLux Pro™ icon in the Finder to open it, MacLux 
Pro™ automatically creates a new plot. Any new plot is created with the following defaults: 
•The size is the current printer's page size. •The scale is set to 1/4” (or 1:50) which is standard 
for MacLux Pro™. •Text fonts are Times, Geneva and Courier. After you have made a new 
plot, you will want to set the Document Size to be sure it is large enough for the drawing you 
want to create.

Problems ?

MacLux Pro reads the page size from the current printer. If you don't have a printer selected, 
you will not be able to print. In this case, the best thing to do is to select the LaserWriter 
driver in the chooser. This will allow you to proceed until you are ready to print. When you 
choose a new printer, you may wish to check the settings in Page Setup and Document Size.

If you get a message saying "Some fonts in this document are not available," then you don't 
have one of the default fonts installed. (All three come with the System software from Apple.) 
You can select new fonts using the Text Fonts commands found in the Controls menu.

Open... (cmd-O) allows you to open a previously saved plot. If you open a plot created with 
an older version of MacLux Pro™, it will be updated to the current file format. But, you will 
no longer be able to open it using the old application. The number of plots you can have open 
at a time is limited only by available memory. MacLux Pro™ will inform you if there is not 
enough memory to open a requested file.

Problems ?

If you don't have enough memory to open a plot, you can assign more memory to the MacLux 
Pro™ application. Quit MacLux Pro™. Select the MacLux Pro™ icon in the Finder and 
choose Get Info from the File menu. Use the popup to select Memory and increase the 
preferred size.

Other problems may be similar to those with creating a new plot, see explanations above.
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Close (cmd-W) should be selected when you are done with the active window. You can also 
close a window by clicking the box in the upper left hand corner. If the window belongs to a 
plot and you have made any changes since it was last saved, MacLux Pro™ will ask if you 
would like to save it before closing. 

Save (cmd-S) saves the active window to disk. If the window belongs to a plot and has not 
been previously saved, MacLux Pro™ will give you a chance to name it and to specify its 
location. Otherwise, Save replaces the old file with the new contents. If the window is a 
paperwork report, it will be saved as a text file.

If the top window is a PaperWork window, then the report will be saved as a TEXT file.

Save As... gives the option of saving the plot in the active window as either a Plot, Stationary, 
or PICT file.

❍     A Plot is the main MacLux Pro™ file type. It contains all of the plot's information. 
❍     Stationary is a plot file that can be reused, the original remaining unaltered. MacLux 

Pro™ prevents you from accidentally saving over a stationary document. 
❍     PICT files can be imported into many Macintosh® applications, especially drawing or 

CAD programs. The PICT file will contain the exact view on the screen, including any 
selection, etc. 

Revert To Saved discards any changes made to the current plot after the last time it was 
saved. MacLux Pro™ asks you to confirm that you want to revert to the last version saved (in 
case you selected this item by accident).

Document Size... can be set in three ways, either by pages, inches, or pixels. MacLux 
Pro™ always initially shows the current size in terms of the number of pages it will take to 
print. Selecting pages, inches, or pixels changes only the unit of measurement, not the size of 
the plot.

To change the size of the plot, select the type of units, enter the new size (height and width), 
and click OK.

The Apply button will change the size of the plot so that you can see its effect when you 
switch to different units. The PICT Size button changes the plot's size to be the same as that 
of the first PICT layer.

The size is specified in Width and Height. So, a plot that is 2x2 pages actually has a total of 
four pages. The maximum width or height is limited by MacLux Pro™ to about 20 feet. Some 
printers, however, also have a limited number of pages they can print at a time. A 
LaserWriter®, for example, is limited to 127 pages.

Note: The section window can have its own document size. Choosing Document Size when 
the Section window is active, sets the size of that view.

For more information about methods of setting up your plot for different output devices see 
About Output Options & Strategies.
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Page Setup... controls printing on the chosen printer. You can usually select the paper size 
and orientation, as well as a number of options for the individual printer. 

There are two page setups that are saved with the plot. If the plot window is active, the page 
setup will refer to printing the plot window. If a paperwork window is active, the page setup 
will be for printing paperwork.

Note: The Color Printing option in the Preferences allows color printing. You may want to 
turn color printing off if you are using a black and white printer. Color printers are not always 
able to reproduce the lightest colors that are used on the screen to represent gel color. If you 
are not seeing some of the lighter symbols, you may need to adapt the color representation to 
something that your printer or plotter can reproduce. You can do this by changing the color in 
the Color Library.

Print... (cmd-P) sends the active window to the printer.

Quit (cmd-Q) closes all open plots and exits MacLux Pro™.

 

About Output Options & Strategies

A plot may take more than one page to print. Most desktop printers have a maximum paper 
size of 11x17 or smaller. In which case, you can trim the pages and fasten them together. The 
resulting plot can then be Xeroxed onto a single large piece of paper.

Alternatively, you can use Page Setup to scale the output to 50% in order to get the plot to 
print on one page. Then, take the half size plot to a copy center with a large format machine 
and have them blow it up to 200%. There may be some loss of resolution when you do this. 
But, it is quicker than assembling separate pages.

MacLux Pro allows you to print to a plotter with a chooser level driver such as 
PLOTTERgeist™ or MacPlot Professional. Otherwise, you must export the plot as a PICT 
file and use your plotting software to send it to the plotter. (Some CAD programs have plotter 
drivers included. The same method can be used to plot through a CAD program.)

MacLux Pro operates best in 1/4" or 1:50 scale. To get a larger or smaller scale plot, it is best 
to use the printer driver to scale the output. For example, to print a 1/2" light plot, use 
MacLux Pro™ (in 1/4" scale) and then use Page Setup to set the output to 200%.
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Undo (cmd-Z) cancels your last action. All actions and some commands are undoable. Undo 
works with the Draw, Line and Arrow tools. If you mistakenly draw a light or a line or move 
something to the wrong place by accident, undo will reverse whatever you did. Undo also 
works with many commands such as Duplicate. So, if you make six copies of the selection 
instead of one, you can start over and try again. 

About Copying and Pasting Info In addition to using Cut and Copy to place copies of 
objects on the clipboard, MacLux Pro™ also stores the information attached to the selected 
objects. This allows you to "paste" this information into other objects. A simple example 
would be copying a light's color and pasting it into several more lights. The fields of 
information that are transferred by the Paste Info command are determined by the Paste 
Options dialog. In the previous example, you would set the Paste Options so that only the 
light's color and symbol color were transferred by the Paste Info command.

In order to allow for the pasting of information in addition to copies of objects. MacLux 
Pro™ maintains clipboards in multiple formats. There is the regular Mac clipboard which 
allows you to copy and paste PICT and TEXT between MacLux Pro and another application. 
MacLux Pro™ also has a clipboard which stores copies of entire objects. Finally, MacLux 
Pro™ has clipboards that store the information attached to lights, lines, and cues. These final 
three clipboards are used for the copying and pasting of fields as determined by Paste 
Options.

The way that Cut, Copy and Paste behave in MacLux Pro™ is determined by context. There 
are two main rules to remember. First, Cut and Copy work normally except that when a single 
object is selected, information is also stored for later use with Paste Info. Paste works 
normally when no objects are selected. When objects are selected, Paste becomes Paste Info 
and will cause information to be transfered to the selected objects. Which fields of 
information that are transfered by Paste Info are determined by Paste Options.

Cut (cmd-X) removes the selected object(s) or cue. Cut also copies the selected objects to the 
clipboard in several formats. It stores copies of the selected object(s) for use within MacLux 
Pro™ as well as a PICT copy for use with another application. If a single object is selected, 
its information is also stored for use with Paste Info. In cue mode, Cut removes the cue and 
stores its levels and info to be used with Paste Cue.

Copy (cmd-C) copies the selected objects to the clipboard in several formats. Copy stores 
duplicates of the selected object(s) for use within MacLux Pro™. When objects are copied 
from the plot window, a PICT copy is stored for use with another application. When objects 
or lines of text are copied from a paperwork window, a TEXT copy is stored for use with 
another application. If a single object is selected, its information is also stored for use with 
Paste Info. In cue mode, Copy stores the levels and info from the current cue to be used with 
Paste Cue.
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Paste (cmd-V) can change to Paste Info or Paste Cue, depending on the tool and if objects 
selected or not. With the arrow tool and no objects selected, Paste takes copies of objects 
from the “objects” clipboard and places then in the plot. You can only Paste when no objects 
are selected. Otherwise, when objects are selected, the name changes from Paste to Paste Info. 
In which case, information is transferred to the selected objects. The fields of information that 
are affected are determined by the paste options. (see About Copying and Pasting Info). 

Paste Info replaces the selected objects’ information with the information of the same type 
stored on the clipboard. Only those fields that are checked in the paste options are transferred. 
You can Paste Info to multiple objects, the selected lights get light information and the 
selected lines get its line information.

Paste Cue places either the cue info or the levels (or both) from the “cue” clipboard into the 
current cue. Whether the info or levels is pasted is set in the paste options. In the cue sheet 
Paste Cue affects the selected cue.

Clear (delete or backspace) removes the selected objects without saving any of their 
information.

Select All (cmd-A) selects all the objects in the plot. If the active window is a PaperWork 
window, then Select All selects every line in the report.

Select Lights (cmd-F) allows you to cause lights that match either the current symbol, or 
some text, or both to be selected. You can, for example, select all lights which contain "R80" 
in their color field. (If symbol and text are checked, then only lights matching both will be 
selected.)

If Replace With is checked, the selected fields in lights matching the search criteria will 
be replaced with the new text. Note: when using the replace function, undo is no longer 
available if you switch to the plot window.

Set Paste Options is a shortcut that will cause the paste options to match the fields 
selected in this dialog. This is useful if you want to paste into one field based on the contents 
of another. For example, you might wish to put "Blue Wash" into all lights containing "R80" 
by setting the paste options to only the group field.

Select Lines allows you to Hide, Show or Select lines based on their type. For example, 
you could use this command to hide all the dimension lines in your plot. You can also do the 
same things based on if the lines contain some text in either their name or their note fields.
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Choosing a Layer from the PICT Layers menu causes the control window for that layer to 
be brought forward. PICT Layers can be used to import ground plans or set drawings into 
your plot. You can use the layers in any combination and turn them on and off. PICT Layers 
are displayed in under the rest of the plot. Note: If a PICT Layers is opaque, it may block the 
view of a layer below it. 

You can import a PICT file using the Open (cmd-O) command or by clicking the Import… 
button. The control window lets you Paste (cmd-V) a graphic from the clipboard into the 
layer. You can also Cut, Copy and Clear the PICT from the layer. If Keep Location 
When Changing PICT is checked when you import or paste a PICT into a Layer, the 
new PICT's upper left corner will placed at the same location as the current PICT's upper left 
corner. If Combine New with Existing PICT is selected when you import or paste 
a PICT into a Layer, the new PICT will be added to the current PICT.

You can select if the layer will be displayed in plan or section view or not drawn at all. The 
Change Name button lets you name the PICT layer. The Faster Screen Drawing 
check box can improve the speed of drawing the pict layer because it converts it into a black 
and white bitmap for onscreen display. The full graphic resolution of the pict layer is used for 
printing.

The Align PICT To popup menu lets you place the PICT in relation to the plot. If the 
Use Center Point box is checked, then the centering options will adjust the PICT to 
the plot's center point, instead of centering it in the drawing (in case the center line is not at 
the center of the paper). The N, S, E, W buttons let you Nudge, Bump, or Shift the PICT 
in the desired direction. A nudge is 1 pixel, a bump is 10 pixels and a shift is 100 Pixels. The 
arrow keys have the same function as the direction buttons and the “,”, “.” and “/” keys will 
select how far.

While PICT Layers are designed to be used for things such as ground plans, you may also 
want to include smaller graphics or text with your plot. PICT Objects is a list of smaller 
graphics or text that you can drag around and place on your plot. You may elect to show or 
hide any PICT Object in the list. There are four different types of PICT Objects available to 
you, simple PICT, text, title block, and key block. Selecting an object from the list and 
clicking the Edit button allows you to name the object and set its contents.

Simple PICT objects are graphics that you can paste into your plot. Use the Paste, Copy 
and Clear buttons to access the contents of this type of PICT object.

Text objects display their names on the plot. By clicking the Options button you can 
choose the font and style for the text.

Automatic Title and Key Blocks are generated by MacLux Pro™ based on the contents of 
your plot. There are some options available for these objects. For example, you may select a 
text font for use when MacLux Pro™ generates the object.

You may personalize your copy of MacLux Pro™ by pasting a logo into the application. The 
logo can then be included your plot's automatic title block. Warning: To change the logo, you 
will need the software key that corresponds to your serial number.



MacLux Pro™ User Guide

Reference Section->Edit Menu-> Sound, Color

The Sound Menu contains commands which allow you to attach a recorded note or sound to 
your plot. Play Note will play a sound note saved with the current plot. Record Note allows 
you to record a note if you have a Mac equipped with a microphone or other sound input 
device. A plot must be saved before a sound can be added. Delete Note removes the sound 
note from the file. 

Color menu commands select colors and control how MacLux Pro™ associates names with 
colors displayed on the screen. Each light symbol can be displayed in color. The symbol color 
is different than a light's color name which is part of its info. For example, a light may have 
the color R55 in the color field of its information. It may also be displayed on the screen in 
light purple. MacLux Pro™ allows you to create and edit a library that associates color names 
with screen colors. The color library is stored in the preferences file. You can access the color 
library using the Color Library command found in the Setup menu.

Set Color... (cmd-K) lets you choose a symbol color for the selected light using the standard 
Apple color picker.

Explore Color... (cmd-option-K) lets you choose a symbol color for the selected light using 
the MacLux picker which allows you to see color relationships. The MacLux picker searches 
the Color Library and tries to match a screen color to a named color.

Default Color... sets the color for drawing new lights. This color is also used to display the 
sample symbols in the key.

Model Color… sets the base color of the 3D model (see Show Model ). The default color is 
white. This can be used, for example, to show the effect a red light has on a blue surface.

Remember Color saves the selected light's color name and symbol color to the Color 
Library. If a color with that name already exists in the library, MacLux Pro™ will ask if you 
want to replace it.

Use Library Colors looks up every light's color name in the library. If there is a match, 
MacLux Pro™ uses the library color for the light's symbol color. If there is no entry for a 
light's color name, Use Library Colors does nothing.

Paste Options... (cmd-option-v) lets you specify which fields will be transferred when you 
Paste Info or Paste Cue. A good example of a use for Paste Options is the ability to paste a 
new color into a selected group of lights without altering their individual channel and circuit 
assignments. (see About Copying and Pasting Info).

Preferences... are read from the “MacLux Pro Prefs” file that is included in the 
application package and is necessary for MacLux Pro™ to run properly. See Locating the 
Prefs File for how to access this file if it is necessary. Note: v2.1 OS X users will find the 
Preferences command in the MacLux Pro menu.

The prefs file controls several options and contains the libraries. The MacLux Pro Prefs 
file that comes with MacLux Pro™ contains pre-made libraries for colors, key information, 
and lamp codes. There are quite a few colors included in the color library. The key library 
includes information on specific models of lights by various manufacturers. Note: The 
information in the libraries was taken from literature of the respective manufacturers and may 
or may not be accurate. You have the responsibility of determining whether the information is 
correct and suitable for a given purpose.
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Color can be turned Off and On. Color is automatically turned off on machines without 
color QuickDraw. With color on, light symbols and beams can be displayed in color. 

When Auto Color is on, MacLux Pro™ checks the color library each time OK is clicked 
in a light's info dialog. If it finds a match for the selected light's color name, MacLux Pro™ 
uses the library color as the light's symbol color.

Note: The basic color library includes the colors Rxxx, Lxxx and Gxxx. To have Auto Color 
work properly, the color name must match. “x80” and r80, or “R 80” won't work for “R80” 
unless you add entries or change the library.

With Color Printing checked (and a color capable Mac), the plot will be sent to the 
printer in color. Unless you have a color printer, you should make sure this option is off. This 
will speed up printing quite a bit.

Note: With some color printers, the lighter colors will not print or print as white. You may 
need to edit the color library to slightly darken the screen color so that it will print on your 
printer.

If Export In Color is selected (and you have a color capable Mac), PICT files will be 
exported with color information.

MacLux Pro™ can use scale measurements expressed in either the English (Feet and inches) 
or Metric (Meters and centimeters) system. Changing this setting has no effect on existing 
plots. To change a plot’s scale system, use the Scale... command and click the Set button.

Play Note on Open will play a plot’s sound note when it is first opened.

+/- Coordinates causes distances to be displayed as + and - relative to the center point 
of the plot (+1’-0”, -3’-6”). Otherwise, MacLux Pro™ displays coordinates in stage directions 
(US 1’-0”, SR 3’-6”). Upstage (US/+) is toward the top of the screen. Downstage (DS/-) is 
towards the bottom of the screen. Stage Left (SL/+) is towards the right of the screen and 
Stage Right (SR/-) is towards the left of the screen.

Number/Mark Double-Click enables direct edit of a light's number and mark fields by 
double clicking on them (double clicking is always enabled for the color and channel fields). 
There is a drawback to allowing double-clicking of the number and the mark. They are inside 
the symbol and are often hit by mistake when you are trying to double click the symbol.
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Black Only Outline will cause MacLux Pro™ to always display symbols that are 
colored black as outline rather than solid. This means that if you use solid symbols to show 
the color of the lights better, you won't end up with ugly black symbols when the light doesn't 
have a color. Instead, these lights will be drawn as black outlines. Practically, this option lets 
you Select All and switch between solid and outline, without separately dealing with the 
black symbols. 

Broadway 16s cause the 6x16 symbol to have a short barrel. If this is unchecked, the 
6x16 symbol has a longer barrel as in the USITT standard. Note: switching from one style to 
another does not automatically change the size of symbols in existing plots.

Select After Drawing causes MacLux Pro™ to switch to the arrow tool and select a 
new object immediately after it is drawn.

The Startup Palette button allows you to chose which of the three preset palettes MacLux 
Pro™ will start with when you create a new plot. You can customize any palette using the 
Symbol command.

Locating the Prefs File

The “MacLux Pro Prefs” file is located in the application package. You may want to 
access this file when upgrading to a new version of MacLux pro in order to preserve any 
custom library entries or symbols you have created.

To find the “MacLux Pro Prefs” file, you must open the application package by holding 
down the control key and clicking on the application icon. From the contextual menu select 
"Show Package Contents"

The “MacLux Pro Prefs” file is located in the "Mac OS Classic" folder next to the 
MacLux Pro™ application itself.
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Commands in the Selection menu operate on the currently selected objects. To select an 
object, click on it with the Arrow tool. To select more than one object, drag the Arrow tool. 
All the objects inside the gray rectangle when the mouse is released will be selected. Holding 
the shift key down while clicking on an unselected object will add it to the selection. 
Conversely, holding the shift key down while clicking on or dragging around already 
selected objects will remove them from the selection. 

Some Selection menu commands operate only if a single object is selected. Some operate 
only on lights, some operate only on lines. This is usually fairly obvious from context and the 
menu commands will be highlighted only if the selection is appropriate for their use.

The Info (cmd-I) command allows editing of the information attached to a single selected 
object. Double clicking an object with the Arrow tool is the same as choosing Info from the 
menu.

In the info dialog for a line, you will see that a line has a name and note field attached. Both 
fields may be drawn on the plot. There are two general flavors of lines, position and 
graphic. Position lines interact with lights and appear in the paperwork. Graphic lines are 
just lines on the plot but may be of either plain, dashed or dimension types.

The height is used for beam calculations and for the section view. In section view, position 
lines are shown in red and graphic lines are shown in green. Any line may also be hidden. 
The text of hidden lines is still visible as long as the appropriate draw box is checked in the 
line's info. Hidden position lines still interact with intersecting lights. You can select hidden 
lines by dragging the arrow tool over their general location or by clicking on any of their text.

The numbering options determine how lights on this line will be numbered. The default is to 
number stage left (SL) to stage right (SR) and up stage (US) to down stage. (Or, right to left, 
top to bottom looking at the plot window). If you manually enter instrument numbers then 
you might want to check Don't Number so you don't accidentally renumber the lights. 
Layout From End tells MacLux Pro™ to measure from the end of the line instead of the 
center when automatically aligning instrument symbols.

Using the Light Info

The info dialog for a light has many more fields of data attached than a line does. In addition 
to entering data in the various fields, clicking the Drawing button lets you choose which 
fields will be drawn on the plot. If the Draw N/C box is unchecked, a color named “N/C” 
(no color) will not be drawn, but all others will. The Opaque box places a white rectangle 
behind the text making it stand out from the background.

The channel is how you, the designer, control the level of a light. This may be a slider on a 
preset board or a number entered into a computer. A lighting instrument plugs into a circuit. 
This may or may not be the same as the dimmer, which actually changes the voltage going to 
the light.

In between the instrument's circuit and the designer's channel, there may be a load patch 
where circuits are assigned to dimmers. There may also be a soft patch where dimmers are 
assigned to channels. In any particular theatre you might find a combination of all of these 
numbers or only one. In a dimmer-per-circuit theatre, for example, the dimmer numbers are 
the same as the circuit numbers.
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The channel, circuit and dimmer fields can all contain a single character following the 
number to denote re-patches. (examples: 12a, 6B, 101c, etc. NOT “12AB” or “101 a”) Using 
this format will insure that the paperwork will sort correctly and the Unused list will count the 
appropriate numbers as already used. 

A designer may want to create a group of channels that have the same basic function, such as 
“blue backlight.” This can simplify the process of cueing by allowing all of the channels in a 
group to be controlled as if they were a single super-channel. Using a combination of the 
group, focus and note fields can convey quite a bit of information about the use of any 
particular lighting instrument.

The mark field can be used to denote a template, or to show the light's focus area (or anything 
else you can think of…). It was created to allow the flexibility to put another bit of 
information on the plot, without specifying what it is used for. Using the Names command, 
you can call this field anything that makes sense for your particular situation.

If the entry in the color field matches an entry in the color library and auto color is on in the 
preferences, the symbol will be colored with a representation of that gel. To link a light to a 
color scroller, the entry in the color field should match the ID of the scroller.

The title of any of these fields can be changed using the Names command in the Reports 
menu. For example, you might wish to call the “template” field “gobo.”

The spacing dialog controls the action of Move, Duplicate, New Object(s) and Set Line. The 
distance an object is moved, the spacing of lights or the length of a line can be set by 
specifying a distance and direction. The buttons N,S,E and W are a quick way of entering a 
direction—0° (N) is the top of the screen. MacLux Pro™ calculates the number of pixels for 
the entered distance and current scale. If desired, these X and Y coordinates may be entered 
directly. The Duplicate and New Object(s) commands allow multiple copies of lights. The 
number is determined by the 'Number of Units' field.

Move (cmd-M) offsets the selected object(s) by the distance and direction shown in the 
spacing dialog.

Duplicate (cmd-D) clones the selected object(s), offsetting the copy by the distance & 
direction entered. You can make more than one copy of the selection. The number is 
determined by the spacing dialog.

New Object(s) is similar to Duplicate. If a light is selected, new lights (of the current choice 
of type and direction) are created instead of clones. If a line is selected, a new line is created, 
starting at the end of the selected line.

Using the Field Drawing command, you can hide or show the fields of selected lights and 
lines. To use the dialog, just choose the fields you want to change and push the appropriate 
button. You can also make fields opaque or transparent. Opaque means that there will be a 
white rectangle behind the text making it stand out from the background

Show Selection will cause MacLux Pro™ to attempt to move the currently selected objects 
into view. If the selection is large, it will be centered in the plot window.
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Set Line sets the length of the selected line(s). It places a line's end point the specified 
distance and direction from its starting point. Set Line uses the spacing dialog which is 
explained on the previous page. 

The Endpoints command operates on a single selected line and provides two related services 
in one package. First, Endpoints can be used to set the coordinates of ends of a line, which 
can allow precision layout. (The coordinates are relative to the center of the plot) Second, 
when Map To 3D Points is selected, Endpoints allows you map the ends of the line to an 
actual 3D position. Mapping a line into 3D gives the ability to show a position in plan view 
for clarity on the plot and still model the beams of lighting instruments hanging on that 
position as if it were somewhere else in 3D space.

A common example is the practice of showing sidelight booms for dance lighting in plan 
view and indicating their actual upright positions elsewhere on the plot. MacLux Pro™ uses a 
metaphor that associates a light symbol with a position line. This model works well for 
paperwork, but doesn't always work for rendering beams, etc. This is because booms are 
almost always drawn as a mini section (on the otherwise plan view light plot!).

In order to be able to mix metaphors while keeping ease of use, Endpoints, "maps" the 
endpoints as drawn in plan view to "actual" endpoints in 3D space. Once you've done this, 
MacLux Pro™ knows where to place the lights that are drawn on that position for rendering 
purposes. You can use the Stand Vertical On End button to map a line into 3D as it 
were standing upright.

Number Lights numbers the lights on the selected line. If a single line is selected, MacLux 
Pro™ will ask what number to start with. You can also choose a number of Segments Per 
Unit which will number the lights 1a, 1b, 1c… If more than one line is selected, the lights 
hanging on each will be numbered starting with 1.

The fastest way to number all the lights in the plot is to use Select All. With everything 
selected, Number Lights will number the lights on every position. If you've custom numbered 
a position, you can select Don't Number in its info options which will prevent you from 
accidentally renumbering it.

The Symbol Drawing menu allows you to choose if the selected symbols will be drawn as 
Outline or Solid. The Preferences option, Black only Outline will keep black color symbols 
from being drawn as solid.

R&R reverses and repeats the selected lights with respect to the center of the line on which 
they hang. If a light is not hanging on a line, R&R does nothing. For example, a light is 
hanging 8 feet off the center of its position, pointing towards the center. R&R will create a 
duplicate light 8 feet from center on the opposite side. But, it too will be pointed towards 
center.

Rotate (cmd-R) rotates any selected lights 45° clockwise. You may also select a direction by 
using the arrow (cursor) keys and the selected symbols will change to the new direction. 
Holding down the option key while using the arrow keys will cause the direction selected 
to be 45° clockwise of the direction of the arrow.
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Arrange Text Fields (cmd-J): When you draw a new light, MacLux Pro™ tries to place the 
text fields using its best guess of the proper position. This means channel in back, color in 
front, etc. If you don't like where MacLux Pro™ placed the fields, then you can drag them to 
where you want them. Often, however, you want a group of lights to have the same relative 
placement of their text fields. MacLux Pro™ allows you to copy a selected light's placement 
of its text fields and then use that placement as a model for other lights. The process is similar 
to how your word processor lets you apply a style (or ruler) to some text to format it. 

To use Arrange Text Fields, you must first copy the text field placement of the light you want 
to use as a model. So, you select the light and choose Copy (cmd-C) from the Edit menu. 
Then, you select the lights that you want to have the same field placement. Finally, you use 
Arrange Text Fields (cmd-J) to move the selected lights’ text fields into the same positions as 
the model.

In the following example, the fields of Light #5 are arranged as desired. Light #5 is then 
selected and copied (cmd-C). Lights #1, #2, #3, and #4 are all selected by dragging the Arrow 
tool. Then Arrange Text Fields (cmd-J) is used to produce the following result:

Focus sets the focus of the selected light. As in real life, a light is focused by pan and tilt. The 
tilt is the Plan Distance (distance on the floor) between the light and its aim point. The Pan is 
the number of degrees from the top of the screen to the an imaginary line between the light 
and its aim point. The aim point is always relative to the light's position. The Show In 
Reports checkbox enables the reporting of the aim coordinates in paperwork reports.

MacLux Pro™ generally determines the beam parameters for a light by looking in the key. 
But some lights, such as fresnels, have an adjustable throw. Checking the Variable Beam 
box causes the spot/flood control to become active. (Leave the box unchecked for a fixed 
focus unit like a 6x9).

MacLux Pro™ sets Spot/Flood to the range specified in the key. If you want to see or directly 
manipulate the information for a light, check the Show Details box and the dialog will 
open to reveal the beam and candlepower information. Candlepower does not necessarily 
vary linearly between the spot and flood values. However, this is the only way MacLux Pro™ 
can use to interpolate to determine the candlepower of a variable beam instrument. (The best 
guess.) You may enter an actual candlepower and disable interpolation by unchecking the 
Compute Candelas box.

PAR lamps have an oval rather than circular beam pattern. For example, a wide par64 has a 
field angle of 45°x71° MacLux Pro™ uses the Beam Range instead of the Beam Spread from 
the Key to calculate a PAR's beam. The Beam Range is used as two separate angles that 
correspond to the dimensions of the beam. The lamp axis is generally determined by the order 
of the angles (45-71 or 71-45). Since it is desirable to determine the axis of individual PARs, 
the Variable Beam check box is replaced with Rotate Lamp Axis 90° in the Focus 
dialog.
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The Beamspread command show you statistics about the beam of the selected light. It shows 
the diameter of the beam at the focus point and the length of the beam on the floor. (You can 
see this graphically by looking at the section view with the light turned on.) Beamspread will 
also give you the horizontal and vertical illumination at the center of the beam in foot-candles 
or lux. 

Focus»Note places the focus point of the selected light(s) into the note field. The point is 
expressed in coordinates relative to the Center Point at the floor plane. Options for the 
rounding of dimensions are found in the Dimensions dialog (under Controls). The focus 
information is added to the existing note rather than replacing it.

The Auto-Fill command can be used to automatically enter a sequence of numbers in the 
channel, circuit, dimmer, or unit number fields. For example, you can select six lights and 
have MacLux Pro™ number their channels from 15 to 20. You could also set the first two 
lights to channel 15, the next two to 16, and the last two to 17 by entering 2 in the "Change 
Every" field. This command is a quick way to avoid a lot of repetitive data entry.

The order that the lights were selected is the order that the numbering will occur. To insure 
that the lights are selected in the desired sequence, it may be necessary to select them 
individually while holding down the shift key. However, if you select a range of lights by 
dragging the arrow tool, they will be numbered according to how they were sorted by the last 
report you looked at.

The Auto Gobo command creates a gobo accessory, • , inside each selected light that has 
something entered in its template field. MacLux Pro™ does not currently link accessory 
symbols to lights. The Auto Gobo command can reduce the tedium of placing gobo symbols 
in each light that has a template. In some cases, it may be easier to delete unwanted gobo 
symbols and then create new ones with Auto Gobo.

The Create Dimensions command can be applied to selected lights to create dimension lines 
that show the lights’ spacing. Options for dimensioning and the rounding of dimensions are 
found in the Dimensions dialog (under Controls). Create Dimensions makes a dimension line 
between two selected lights. A single selected light dimensions to the center or end of its 
position, depending on if the line's Layout From End option is active. If a group of lights are 
selected, the dimensions will be created based on the order that the lights were selected. To 
insure the correct sequence when dragging the arrow tool to select a group of lights, first open 
the instrument schedule so that the lights will be sorted into the correct sequence.

Hint: Here's a quick way to create dimensions for all the lights hanging on a position. Before 
beginning this process, open the instrument schedule to insure the lights are sorted into the 
correct order. Then, you can hold down the command key while clicking on a position. This 
should select all the lights as well as the position line. Choosing Create Dimensions will now 
make dimension lines for the lights. If the position is dimensioned from the center and there is 
no center light, you may want to delete the dimension line that spans the center and 
individually select the two closest lights, choosing Create Dimensions separately for each.
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The Lines menu allows you to select the type and features of lines that will be drawn with the 
line tool. If you have selected lines with the arrow tool, the commands in the Lines will 
change the properties of the those lines. 

The width of lines can be selected using the 1Pixel, 2 Pixels, and 3 Pixels commands. You 
can also select line widths by pressing the keys 1, 2, or 3 on the keyboard.

The Line tool draws two general types of lines. Lines representing places to hang lights are 
referred to as Position lines. Other lines are various styles of Graphic lines. The main 
difference between Graphic and Position lines is that Position lines can interact with light 
symbols for numbering, paperwork, and other purposes. Graphic lines are ignored by light 
symbols. They are just lines on the plot. However, both types of lines can have a name and 
note attached to them.

Graphic lines can be Plain, Dashed or Dimension style lines. Dimension lines show their 
length in their note field.

Any line may be Hidden. You can still select the line using the arrow tool by clicking on 
either the name or note if it is visible. Or, you can select the line by clicking and/or dragging 
the arrow tool as if the line were visible. Position lines can also be selected in the Positions 
report window.
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Set View brings up a dialog box which contains the options found in the rest of the display 
menu. It allows changing several display characteristics at once. Explanations of the separate 
items are found below under their corresponding commands. 

Zoom Out (cmd -) and Zoom In (cmd =) are the same as the - and + buttons in the Set View 
dialog. They increase or decrease the view of the plot by 50%. Zooming in causes symbols to 
become larger (hence +). Zooming out makes them smaller (-).

Show Center Line/Hide Center Line toggles on and off the automatic center line. You can 
set the center point of the plot using the line tool or the Center Point… command in the 
Controls menu.

Show Page Breaks/Hide Page Breaks toggles on and off boundary lines dividing the plot 
into pages. These thin gray lines show how the plot will be printed by the chosen printer. The 
page break lines will be printed unless you turn them off.

Show Pt by Pt/Hide Pt by Pt turns on and off the calculation and display of illumination 
levels on a 2 ft or 1.5 m grid in cue mode (1/4”or 1:50 scale). Points outside of beams are not 
shown. Options for the calculations and for colored numbers are found in the Beams dialog.

Hexagons & Circles On/Off enables and disables the drawing of hexagons around a light's 
channel field. The hexagon is automatically sized to fit up to three characters of most sizes 
and styles of fonts.

Note: The default font for channel fields is Geneva, which creates a fairly large hexagon. 
(Geneva was selected as the default primarily because it is present on almost every 
Macintosh.) Smaller hexagons can be obtained by selecting 8 point Times or Helvetica using 
the Channel Font command from the Text Fonts menu under Controls.

Simplify Symbols changes the light symbols to colored rectangles and hides their associated 
text. This serves to reduce clutter on the screen by hiding a lot of detail. In cue mode, this 
allows the designer to deal with blocks of color rather than types of lights. (This command 
was originally designed to speed up the display of cues on older Macs.)

Hide/Show Small Fonts allows you to skip drawing fields when if they use fonts smaller 
than 6pt in size. Thus, when you are zoomed out, your Mac won't waste time drawing text 
that is too small to read anyway. If, on the other hand, you want to draw fields with tiny fonts, 
this command will let you.

Invert Background changes the position lines and the PICT layers from black on white to 
white on black. It is useful on a color monitor in cue mode because it provides good contrast 
for viewing colored beams.

Hide PICTs/Show PICTs temporarily hides and restores the PICT Layers, without requiring 
that each be turned on and off individually.
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Hide PICT Objects/Show PICT Objects temporarily hides and restores the PICT Objects, 
without requiring that each be turned on and off individually. 

Hide Lights/Show Lights temporarily hides and restores all the light and accessory symbols. 
This can be useful when it is difficult to click on a position because it has too many lights 
hanging on it. Choosing Hide Lights will allow you to “get at” the position underneath the 
lights. (Also useful for selecting a focus point that lies under a light symbol when using the 
Hand tool.)

Hide Cue/Show Cue suspends and resumes the creation of beams in cue mode. Normally, all 
the lights that are “on” in the current cue produce beams which are shown on the plot.

Bring Accs To Front causes all accessory symbols to be drawn on top of all light symbols. 
This is useful if you lose a gobo or iris symbol behind a light and want to see it.

Show Grid/Hide Grid (cmd-G) controls a grid of dots which can be placed beneath the plot 
and ground plan to assist in laying out a drawing. The dots are spaced every 1/8” (1cm), with 
major divisions every 1” (5cm). This grid is for visual reference only. To align objects, use 
the Alignment dialog or the option key when dragging.

Note: The grid is displayed underneath the PICT Layers. If the PICT Layers are not 
transparent, they may hide the grid.

Show Info Bar/Hide Info Bar (cmd `) places a line of information at the top of the plot 
window. It displays the location of the cursor in scale coordinates and other information 
dependent on the tool and the selection.

On the left, the info bar always shows the cursor location in scale coordinates. These 
coordinates are initially relative to the upper left corner of the screen. By setting the Center 
Point, they can show distance stage right and stage left (SR & SL) of center and distance 
upstage and downstage (US/DS) of the plaster line.

On the far right, is the alignment indicator—Å—which is present if objects will be aligned 
(either always align is checked in the Alignment dialog or the option key is down).

When any tool, except the hand tool, is clicked and dragged, the center portion of the info bar 
shows the position of the cursor relative to the point where the mouse button was pressed. 
Like the overall cursor location, the drag distance is in scale (feet and inches or meters and 
centimeters).

When the Arrow tool is active and a single object is selected, the object's information is 
displayed in the center of the info bar. When the Draw tool is active, the type of light selected 
to be drawn and the direction it will point are shown on the right of the info bar. When the 
Line tool is active, the selected width is shown on the right of the info bar. When the Hand 
tool is active, the current cue's info is shown in the center of the info bar.



MacLux Pro™ User Guide

Reference Section-> Controls Menu

Controls Menu 

Chapter Contents

Alignment

Dimensions

Center Point

Alt. Text Drawing

Text Fonts->

Color Font Chan Font Cir Font # Font Mk Font Focus Font

Position Name Font Position Note Font

Graphic Name Font Graphic Note Font

Dimension Note Font

Sections

Beams

Floor Plane

More Options->

Default Light Info

Default Line Info

Scale

Shortcuts->

Swop Fields

Insert Channel

Delete Channel 



MacLux Pro™ User Guide

Reference Section-> Controls Menu-> Alignment, Dimensions, Center Point, Alt. Text 
Drawing, Text Fonts, Sections

Alignment... (cmd-L) sets the options of MacLux Pro™’s automatic alignment feature, 
which aligns objects when you draw or drag them. You can activate automatic alignment by 
holding down the option key when you release the mouse after dragging, or by checking 
the Always Align box in the dialog. Note: If Always Align is checked when the 
Preferences are saved, it will be turned on the next time you start up MacLux Pro™. 

Automatic alignment places a line's end points on a 6” (50cm) grid starting at the center point 
of the plot. Automatic alignment causes a light to center itself on a position line. If the 
Space Lights Every box is checked, a light will also move to an even multiple of the 
desired distance from the line's center or its end. The Starting box, lets you offset the 
regular spacing from a position's center (or end, determined by the its Layout From End 
option). This might be used if you wanted two lights to “split center” rather than having a 
single unit on the center line of the position.

The Dimensions… command contains options for the way that MacLux Pro™ creates 
dimension lines. The Create Dimensions command makes dimension lines that show the 
distance between selected lights. Where these new dimension lines are placed, relative to the 
lights, is selected by the Dimensions dialog. Offset Dimension Lines determines how 
far from the symbols’ center, the lines should be placed.

To determine the length of a dimension line, MacLux Pro™ converts graphic placement 
(measured in pixels) to scale feet or meters. There is sometimes an error + or - 1 inch due to 
integer rounding. The rounding options in the Dimensions dialog help eliminate calculation 
errors. You can round to the nearest 3”/10cm or you can round to the distance specified for 
alignment.

The Center Point is used by the info bar to display the cursor's location in scale distance. The 
Center Point determines the placement of the Grid and the Alignment of lines. The Center 
Point can also be set using the Line Tool: Place the cursor over the desired point, hold down 
the command and option keys and click the mouse.

Alt. Text Drawing… gives you the option of changing which fields are drawn on the plot. 
One use of this command is to easily allow you print two versions of the plot, one showing 
channel numbers and another showing dimmers and circuits.

The Text Fonts menu lets you select the font, size, and style that will be used to draw the text 
fields that can be shown on the plot using the information attached to lights and lines. There 
are separate fonts for each field of a light’s information as well as for different types of lines. 
The extended style, when used with a mono-spaced font such as Monaco, can help when the 
plot will be output using a plotter's built in font.

Sections... controls how the section view is projected. A Front section cuts across the plot 
from left to right. It could also be called a front elevation. A Side section cuts the plot from 
top to bottom and could also be called a side elevation. Show Line Names draws the 
names of positions next to their location (if they are showing in plan view). Show Floor 
draws a line showing the floor or height=0. The display of the floor line is not changed by the 
Floor Plane command.
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The Beams dialog controls options which affect the display of beams and point by point 
illumination calculations. The ovals of beams are approximated by polygons with lots of 
sides. The more sides, the smother the oval appears. But, also the longer it each beam takes to 
calculate. The finest resolution possible is a polygon of 360 sides. However, 40 sides are 
plenty to get a good idea of the size of the beam in a reasonably interactive period of time. 
See this note about other modes of displaying beams. 

Color Beams are displayed using a light's color and the level of its channel. MacLux 
Pro™ also take into account factors such as the candlepower of the unit and the distance of 
the throw. (A 1000w leko is generally brighter than a 500w fresnel at the same distance). A 
monitor has a finite, maximum brightness. The Illumination Scale Max setting is the 
number of foot-candles or lux that is “full bright” on the monitor. Beams which are brighter, 
are shown at full. Otherwise, beams are shown proportionally to the maximum. For example, 
if the contrast is set to 50 fc, a beam that produces 25 fc will be half as bright as one which 
produces 50fc. However, a beam producing 75 fc will be the same brightness as one 
producing 50 fc.

The Use for Raytrace Brightness option allows the Illumination Scale 
Max value to be used as an “exposure” or contrast setting for exporting lighting levels to a 
raytracing program. This may or may not be useful as raytracing programs often have their 
own automatic exposure controls.

The Magic Beams, feature offers an alternative to overlapping ovals for the beam display. 
A regular beam is shaped like an oval. A magic beam is shaped like an arrow. Magic beams 
display much faster than their oval counterparts. More than one or two oval beams can be 
confusing. You can't tell which light is creating which beam. Magic beams link the light to its 
aim point, making it easier to see what is going on in a complex cue. If the aim point is 
directly underneath the light, the magic beam appears as a rectangle framing the light. The 3D 
model and point by point display do not work with magic beams. Hint: Try selecting a spot 
with the Hand tool. (a little cross should mark the spot) Then click on a magic beam's arrow. 
The focus (and the arrow) should jump to the selected point.

The Illumination Scale Max setting is also used to color the point by point display of 
illumination levels. The color of the numbers represents the relative intensity. Points that are 
as bright or brighter than the setting are amber while lower levels range from red to blue. The 
point by point display can show both illumination, the quantity of light falling on the point, 
and Luminance, the brightness of a surface at that point. Luminance is calculated for the 
given Reflectance. Both the illumination and luminance can be shown for either a 
Vertical or Horizontal surface. LUX<->FC switches the units used to display 
illumination points. This allows the display of footcandles while using metric scales or lux 
when using feet.

The Floor Plane is the height at which beams are displayed in plan view. By setting the Floor 
Plane to person height, you will be able to see beams at the size that the actors will pass 
through rather than the size they will be on the floor.

The Default Light Info and Default Line Info commands allow you to preset information 
and settings for the creation of new lights and new lines using the appropriate Info dialog. 
The default line is also used as the home of any lights in the plot that are not hanging on a 
position. You may want to specify different positions for instruments that are “floating” on 
the plot, i.e. floor or set mounted. The best way to do this is to place a hidden line under each 
of the floating lights. You won't see the line, but the position will be found for the 
PaperWork.
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Scale... is included for backward compatibility. It is highly recommended that you leave 
the plot in 1/4” or 1:50 scale and use the Zoom commands or the Page Setup to change the 
size of the plot. Zooming effectively changes the scale + or- 50%. Other sizes can be printed 
by using your printer's reducing option (Page Setup). A 1/4” (1:50) plot printed at 50% 
reduction is effectively in 1/8” (1:100) scale. 

Both the size of the light symbols and how distance is calculated are determined by the scale. 
The scale is calculated for the current measurement system. If you switch back and forth 
between English and Metric, you will want to be sure to Set the scale in the proper system or 
distances will be incorrect even if the size of the symbols appears fine.

You can choose how changing the scale will affect the plot: &Mac215; Clicking the Set 
button changes only the scale. The next time a distance is calculated, it will be in the new 
scale. Nothing else changes. &Mac215; Clicking the Change All button changes the scale 
and re-sizes all the light symbols. All text fields will return to their default positions with 
respect to the new symbols. &Mac215; Clicking the Resize button will change the scale 
and resize the entire plot including PICT layers to the new scale.

Shortcuts are ways of moving information around without having to go to each individual 
light and make the change. You can swop or copy information from field to field or renumber 
your channel assignments.

Swop Fields... is an operation that swops or copies information from one field to another 
within each light's info. This can be useful if, for example, if your lighting system is dimmer-
per-circuit and therefore you may wish to make all the dimmer numbers the same as all 
circuit numbers. With the Swop Fields command, you don't have to enter them twice, just 
Copy them.

Insert Channel and Remove Channel renumber the channels starting with the specified 
number. Both commands do nothing to lights with lower channel numbers. Insert increases 
(+1) each channel greater than (after) the number. Remove places a blank anywhere it finds 
the Channel number and decreases (-1) each channel that is greater than the number.

Insert Channel and Remove Channel also update the channel/level information in the cues so 
that levels track to the appropriate lights. Undo will not revert the changes to cue information. 
But, you can use one command as the reverse of the other. Remove Channel can be used to 
undo an Insert Channel. Undoing a Remove Channel is trickier because Insert Channel will 
not put a number in lights with blank channels—you must undo that by hand.
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Key... allows access to the key information for the symbol selected by the lights palette. The 
key can also be accessed by double clicking on a symbol in the palette as long as no objects 
are currently selected. This brings up the key dialog which is a gateway to tell MacLux Pro™ 
everything about the selected symbol. 

The key dialog allows you to name the current symbol and tell MacLux Pro™ how many of 
this type you have available. There is a popup menu which allows you to set the flavor of the 
symbol. The flavor determines the general behavior of the symbol. The broadest classes of 
flavors are lights and accessories. Flavors of lights interact with position lines while accessory 
flavors do not. Another example of the behavior of different flavors is that PAR lamps have 
oval beams while other flavors of lights do not. (Flavors do not change the behavior of a 
symbol until you have clicked OK.)

Note: The circle accessory, the third to last symbol in the bottom right of the palette, is an 
exception. You can never change the flavor of the symbol(s) that occupy this slot. This slot 
will always be a 4 in 1 accessory.

By clicking the Detail button you can access other, more detailed information about the 
symbol such as the size of its beam and its candlepower. The Symbol button allows you to 
choose another symbol using the symbol picker (which is the same as selecting the Symbol 
command). The Key Library button gives you access to MacLux Pro™'s library of 
information about specific lighting instruments (and is the same as choosing the Key Library 
command).

Color Scrollers are set up by clicking the Detail button of a symbol whose flavor is set to 
Scroller. This will bring up the list of color scrolls. Each scroll is named and that name is 
referenced by the individual color scroller symbol when it is used in the plot. If all of your 
scrollers are equipped with identical colors, you will only need one scroll for your entire plot. 
A scroll itself is a list of colors and levels that correspond to those colors. You can create and 
edit the list of colors by selecting the scroll and clicking the edit button. The scroll edit 
dialog allows you to add and delete colors and levels to your scroll. For the scroll to work 
properly, you will want to enter the colors in ascending order with respect to their 
corresponding levels.

The Symbol… command is what you use to choose a symbol for the currently selected slot in 
the lights palette. This command brings up the symbol picker, which is a dialog that displays a 
selection of symbols. MacLux Pro™ has four sets of built-in symbols plus a fifth set that you 
can use to import your own graphic symbols into MacLux Pro™. You can browse through the 
sets of symbols and select the one that you wish to use by clicking on it. Then, clicking the 
Choose button will assign that symbol to the current slot in the palette.

You may also choose symbols that are associated with entries in the key library. Say, for 
example, you will always use a certain symbol to mean a Source Four 30 degree in any plot,. 
You may elect to have the key library remember that so that when you assign a slot using the 
library, it will also change the symbol as well as the key information.

The arrangement and selection of symbols in the lights palette is stored with the plot. 
However, custom symbols are stored as part of the MacLux Pro™ application. You may store 
a set of custom symbols with a plot file. This will increase the size of the file. However, 
someone with a different copy of MacLux Pro™ will be able to load your symbols from the 
plot and use them. You can load and save custom symbol sets by going to the Custom page 
in the symbol picker and clicking the Load Set and Save Set buttons.
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The Edit button, which becomes active when you select the Custom set in the symbol 
picker, allows you to import your own symbols through the clipboard or from special symbol 
files. Each type of light has eight separate views, one for each possible direction. A symbol 
can also be either outline or solid. This makes a total of 16 pictures you need to create using a 
drawing or painting program in order to fully import a symbol into MacLux Pro™. 

If you use a painting program such as MacPaint®, the symbols will be bitmapped. They will 
not scale or print as well as ones made with a drawing program like MacDraw®. The 
maximum size of a symbol is 64 x 64 pixels. The size of the outline and solid versions of the 
same symbol must be identical. A symbol is always saved at 1/4" (1:50) size. MacLux Pro™ 
creates the other sizes by scaling the 1/4”(1:50) symbol.

The Paste button tells MacLux Pro™ to look for a picture on the clipboard. If it finds one, 
MacLux replaces the currently selected symbol with the clipboard's PICT. The direction 
buttons and Solid check box determine exactly which of the 16 possible views is to be 
replaced. The Clear button removes a pasted symbol (it then reverts to the symbol built-into 
MacLux Pro™).

Import… lets you replace all the views of a symbol at once, by extracting them from a 
MacLux Pro™ symbol file. Export... allows you to create a MacLux Pro symbol file 
containing a symbol that you have pasted into MacLux Pro. Restore deletes all views of 
the current symbol, returning to the default triangle symbol.

The Frames dialog allows you to associate frame sizes (which are found in the key detail for 
types of instruments) with the number of cuts per sheet of color. This is useful for the Color 
List report which totals the number of sheets of each color needed in the plot.

The Lamps library is a list of ANSI and other lamp codes and their associated wattages. This 
allows MacLux Pro to decode key detail and correctly total wattages for the Dimmer and 
Circuit List reports. For example a leko with an FEL plus a fresnel with a BTL decodes to 
1000 + 500 watts.

The Key Library command allows you to browse and manage the key library. You can Add, 
Delete, rearrange and Edit the entries in the library. Double-clicking an entry allows you 
to edit it the same as you would the key information for a symbol. In order to keep changes 
you've made to the library, you will need to click the Save button. (The key library is stored 
as part of the preferences file.)

The Color Library command lets you browse through a list of the colors in the library. You 
can Add, Delete, rearrange and Edit the entries in the library. Double-clicking on a color 
in the list shows you the color, its name, its screen color and a graph of its transmission 
spectrum. Clicking the Use button will transfer the selected entry's name and screen color to 
the clipboard, allowing the Paste Info command to apply it to lights. In order to keep 
changes you've made to the library, you will need to click the Save button. (The key library 
is stored as part of the preferences file.)

The Show... allows access to the information such as show name and venue. The information 
in the show dialog appears in paperwork headings and in auto title block type PICT objects .
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Notes... allows access to the notes which appear in auto title block type PICT objects. You 
can choose to show or not show the notes in the title block by setting the options for the PICT 
object. 

Report Setup contains options which affect both the content and format of reports.

You can display and print reports with a left margin, meaning that space is left at the left 
edge of the paper. Shaded reports have a light gray background behind alternate rows of 
data. If color is on, this is a gray color pattern. With color off, it is a standard gray pattern. 
Lined reports have a lines separating rows of data.

MacLux Pro™ typically labels the fields in each report with column headings. These may be 
switched off by unchecking Show Headers. This would be useful if you were exporting a 
report from MacLux Pro™.

MacLux Pro™ defaults to a style of report that uses subheadings, which are divisions in 
reports. For example in the channel list, each channel is listed on a line and then the lights 
assigned to that channel appear on successive lines. No Subheadings will cause MacLux 
Pro™ to simply list the lights. This style of report uses less paper. But, you would want to be 
sure that the first field displayed in the channel list was, of course, the channel. (Use Chan 
List Setup to do this.)

Ignore Unassigned will cause MacLux Pro™ to skip listing lights that have a blank in 
the field that the report is indexing. Lights with a blank in the channel field would not be 
listed in the Channel List, for example.

Add # to Number Field simply prepends each unit number with a pound character (1 
becomes #1). ANSI>Watts causes MacLux Pro™ to look in the lamp library and convert a 
lamp code to its corresponding wattage when computing loads in the circuit and dimmer list 
reports. Show Positions Info expands the display of the positions report to include 
more than just the name of the position.

Reports can be automatically formatted for page breaks according to the current page setup. 
Or, you can set the number of Lines Per Page. This option might be useful if, for 
example, you were exporting a report to another application and wanted to leave room for a 
header.

The Field Separator can be either a Space, a Tab or a Comma. Tabs are useful for 
use with word processors and proportional fonts. Commas work with spreadsheets and 
databases.

In order for the columns to line up properly, you must use either Monaco or Courier for 
displaying and printing reports. Note: Some versions of these fonts are not truly mono-
spaced. If your columns are not lining up, try switching to the alternate font.

Raytrace Data can be created in several formats. RIB is used for RenderMan® 
compatible applications. POV creates files for use with the Persistence of Vision Raytracer. 
3DMF is included if you want to experiment with QuickDraw 3D.
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The Names… dialog contains a list of strings that appear in reports. The first fifteen are the 
names of a light's fields. In instrument based reports, a light's fields make up the columns and 
the names of the fields are the column headings. Following the field names, there are a 
number of strings specific to the first five reports (such as the name of the report). You can 
change any string either by double-clicking it or by selecting it and pushing the Edit button. 
The Default button returns the selected name to its original designation. 

Optional Fields: MacLux Pro™ needs to know if you're using all three control/circuitry 
fields or just two. In a dimmer-per-circuit situation, the dimmer number is probably the same 
as the circuit number. The same is true if you have a patch panel where circuits are assigned 
to dimmers but there is no channel to dimmer patch. In this case, the dimmer number is the 
same as the channel number. If you're only going to use two fields, use Channel and Circuit 
and ignore the Dimmer field. You can also use the focus field instead of the note field in the 
Magic Sheet.

Field Sizes allows you to set the width of some larger fields in other reports. The widths are 
in characters, with the default shown in parenthesis.

The following commands enable you to configure the order and contents of the columns in 
the corresponding reports: Inst. Schd. Setup, Chan. List Setup, Cir. List Setup, Dim. List 
Setup, Hang. Schd. Setup. All of these commands work the same way.

Selecting one of these menu items brings up a list of the fields contained in that report. You 
can Add and Delete columns. You can rearrange the order of the columns by selecting the 
column name you want to move and pushing the Up and Down buttons.

Double-clicking a column name (or selecting it and using the Edit button) allows you to 
choose which field will appear in that as well as its width, etc. The Width is the number of 
characters allowed in the column. (When you select a field with the popup menu, the default 
width for that field is entered for you.) Left Justified means that the information starts 
at the left edge of the column, instead of the right edge. If the information is larger that the 
width of the field it is cut off. When the Use "…" option is enabled, an ellipsis will be added 
to indicate missing information. If you'd like space to fill in information on your report, you 
can use the blank=____ option to have the paperwork show an underlined space for every 
entry that has a blank in the selected field.
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Show/Hide Lights Palette controls the window that contains the palette of symbols. Most of 
the symbols in the palette represent lighting instruments. There are also accessory symbols. 
The behavior of a symbol as well as what it represents is determined by the key command or 
by double-clicking a symbol in the palette. In the following discussion, "lights" should be 
taken to mean both instrument and accessory symbols. 

The palette allows you to choose the symbol that will be drawn with the draw tool. However, 
if any lights are selected using the arrow tool, selecting a new symbol using the palette will 
change the selected lights.

The MacLux Pro™ application remembers both if the palette was showing and where it was 
located the last time you used the application.

Each plot file can have a different palette of light symbols. The configuration of the palette is 
stored with the plot. You can change the symbol in any space of the palette by selecting it and 
using the symbol command. MacLux Pro™ has four pages of built-in symbols. You can also 
import your own symbols into MacLux Pro™. However, your custom symbols are stored 
inside the MacLux Pro™ application. To attach your custom symbols to a plot file, you need 
to use the Symbol command; click the Custom radio button; and choose Save Set.

Show/Hide Tools controls the window that contains the selection of tools that you use to 
draw and manipulate objects within MacLux Pro™. The MacLux Pro™ application 
remembers both if the palette was showing and where it was located the last time you used 
the application. The tools may also be selected using the keyboard by pushing the key shown 
in parenthesis below.

The Arrow Tool selects and moves objects and text. (g)

The Hand Tool sets the level and focus of lights. (h)

The Draw Tool draws symbols. (d)

The Line Tool draws hanging positions. (f)

The Arrow Tool

Clicking on an object selects it. By dragging the Arrow Tool, you can select multiple objects. 
All the objects within the gray rectangle when the mouse is released will be selected.

Use the shift key to add/subtract from the current selection. With the shift key down, selecting 
an unselected object adds it to the current selection. Selecting a previously selected object 
removes it from the current selection.

Double clicking on an object using the arrow tool brings up the object's Info dialog box, 
which allows editing of its information. Double clicking the arrow symbol itself in the tools 
palette brings up the alignment controls dialog. More->
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The Arrow Tool Continued... 

Holding down the option key as you let up on the mouse causes the objects you are dragging 
to snap into alignment. Note: You must keep the option key down until all the objects are 
aligned.

Holding down the control key and clicking on an object will cause a popup menu to appear 
that has commands that are related to that object. For a light symbol, this gives you direct 
access to some of the fields of information attached to the symbol, without bringing up the 
entire info dialog.

The Arrow tool will allow you to move text or accessory symbols inside of a lighting symbol 
without moving the symbol itself.

Click and drag near the end of a line to resize it.

With the command key, a click on a line selects all of its lights in addition to the line.

When an object or objects are selected, choosing a new direction, symbol or size will change 
that property of the selected object(s). For example, selecting some lights and pressing the up 
arrow will cause all of those lights to point towards the top of the screen.

The Hand Tool

Selecting the Hand tool puts MacLux Pro™ into Cue Mode. The Selection and Lines menus 
are replaced with the Cue menu. In cue mode, levels can be set with the mouse using the hand 
tool, or with keys using the console. Beams are displayed for each light whose corresponding 
channel is greater than zero in the current cue.

The color of a beam is dependent on the light's symbol color, the intensity of its lamp and the 
level of its channel. If the channel is at 0 then the light is off. If the channel is at 100 then the 
light is full bright. The beam is shown in the light's symbol color that has been modified to 
suggest relative intensity. The range of illumination levels (contrast) is controlled by the 
Illumination Scale Max value in the Beams dialog.

Clicking on the plot with the Hand tool allows you to select a point for setting the focus of a 
light. This point is marked with a small cross. Option-clicking a light sets its focus to this 
point. The point is also the location of the 3D cylinder shown in the Model window.

Clicking on a light with the Hand tool and dragging the mouse allows you to set the level of 
its channel. If the symbol is a color changer, a menu of the available colors will popup.

With the option key held down, clicking on a light sets its focus to the selected point.

With the command key held down, clicking on a light and dragging will set the level of all 
channels in its group.



MacLux Pro™ User Guide

Reference Section-> Windows Menu, Tools Palette, Draw Tool, Line Tool

The Draw Tool 

The Draw tool draws light and accessory symbols. Pressing the mouse causes the pencil 
cursor to change to a symbol. The symbol may be positioned before releasing the mouse.

The symbol to be drawn is chosen with the Lights Palette.

The direction the symbol will point is chosen with a combination of the shift and arrow keys 
(for keyboards without arrow keys use: n,s,e, and w).

The last key pressed determines the direction. Once a direction is selected, all symbols will be 
drawn pointing that direction until a new direction is chosen. (It is not necessary to hold the 
arrow key down as you draw.)

Holding down the shift key as you press the mouse button causes the symbol to rotate 45° 
clockwise. For example, first pushing the down arrow; then holding the shift key and pressing 
the mouse, will cause the symbol to point towards the lower left corner of the screen. (Once 
the cursor changes to a symbol, the shift key can be released.)

Holding the option key down as you release the mouse causes the symbol being drawn to 
align itself with a line. If the light is not being placed on a position, the option key does 
nothing. Settings for the alignment of symbols are found in the alignment dialog.

A new light symbol created with the draw tool has the default information set by the Default 
Light Info command. Double clicking the draw tool in the tools palette brings up the default 
light info dialog.

The Line Tool

The Line tool draws two general types of lines. Lines representing places to hang lights are 
referred to as Position lines. Other lines are various styles of Graphic lines. The main 
difference between Graphic and Position lines is that Position lines can interact with light 
symbols for numbering, paperwork, and other purposes. Graphic lines are ignored by light 
symbols.

The Line tool behaves like a standard Macintosh line tool. Pressing the mouse and dragging, 
draws a line. The width and style of lines drawn with the Line tool are determined by options 
in the Lines menu. If any lines are selected, choosing a new width or new style from the Lines 
menu changes all the selected lines to that width or style.

A line's general type is selected using either the Position or Graphic command. The width of a 
line is determined by the 1 Pixel, 2 Pixels, 3 Pixels commands. The width can also be set by 
pressing the keys: 1,2, or 3. Graphic lines can be plain, Dashed or Dimension style lines. 
Dimension lines show their length in their note field.

You can draw lines that are Hidden but it is much easier to draw a visible line, then select it 
and hide it using the Hidden command from the Lines menu. Conversely, to show a hidden 
line, select it and chose Hidden to toggle it back to being visible. More->



MacLux Pro™ User Guide

Reference Section-> Windows Menu,

Line Tool Continued... 

Holding down the option key as you press the mouse causes the starting point of the line to 
“snap” to the closest point on a 6” (50cm) grid. Holding down the option key as you release 
the mouse causes the end point of the line to align itself to the grid, which is anchored by the 
center point.

A new position created with the line tool has the default information contained in the Lines 
dialog (under Controls, pg. 9-7).

Double clicking the line tool in the tools palette brings up the Lines dialog.

A special function of the line tool is to set the Center Point of the plot. To set the center, place 
the cursor over the desired point, hold down the command and option keys, and click once.

Show Model is active in cue mode. It creates a floating window displaying a Lambert shaded 
cylinder. Clicking on the plot with the hand tool "places" the cylinder. Any beams falling on 
that point affect the appearance of the model. The color of the model can be changed with the 
Model Color command. This allows you to show the effect a colored light will have on a 
colored surface. For example, what a red light will look like on a blue surface. After the 
model window has been created, Show Model changes to Save Model PICT which allows 
gives the option of saving the window as a PICT file.

Console... creates (or brings to the front) the console window. The console window looks and 
acts like a lighting console. It displays the level of all the channels in the plot for the current 
cue. On a color monitor, channels displayed in blue are at the same level as the previous cue. 
Gold channels are higher than the previous cue, purple channels are lower.

Choosing Print with the console window active will allow you to print either the current cue 
or all the cues in console format.

When the console is active, the left/right arrow keys correspond to previous/next cue. The 
up/down arrows are first page and page down. Levels can be typed into the Console using the 
numeric keypad using this syntax.
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Console Syntax 

Levels can be typed into the Console using the numeric keypad. The syntax is similar to that 
used by many light boards. It is designed to utilize the numeric keypad on a standard 
keyboard. The keys have the following equivalents:

'=' - At '/' - Full '*' - Cue '+' - And '-' - Thru

'enter' - Enters current command. 'clear' - Clears current command.

Setting Levels:

<Channel> <=> <Level> <enter> {channel at level}

<Channel> <+> <Channel> <=> <Level> <enter> {channel and channel at level}

<Channel> <-> <Channel> <=> <Level> <enter> {channel thru channel at level}

Go to cue:

<*> <number> <enter> {go to cue number}

Examples:

'1','0','=','/',<enter> —Ten at full.

'6','+','8','=','5','0',<enter> —Six and eight at 50%.

'*','3','5',<enter> —Go to cue Thirty Five.

Section View

The section view shows an elevation view of the plot from either the side or the front. The 
section view plots the location of lights, heights of hanging positions and shows any beams 
(in cue mode). The section view is either from the front or the stage right side, depending on 
the setting in the Sections dialog. The section view can have an independent Document Size. 
The section view window uses the same page setup as other paperwork reports when you 
print it.
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PaperWork reports are created in separate windows. The first five reports sort the lights 
according to either position or by channel, dimmer, or circuit. These five are customizable 
using the setup commands found in the reports menu. The other reports have specific 
purposes such as counting cuts of color or templates, etc. All PaperWork windows can be 
printed directly using the Print command. Paperwork windows have a separate page setup 
from the main plot window. They can also be saved as TEXT files by using the Save 
command. 

Many PaperWork windows give you access to information by double clicking on a row of 
text, allowing editing through the paperwork as well as the drawing. If the report has options, 
double clicking a header will bring up the appropriate option dialog. For example, double 
clicking a header in the instrument schedule will bring up the instrument schedule setup, 
allowing you to customize the way lights are listed in the report. Some windows also allow 
the use of Cut/Copy/Paste/Clear and other operations. The commands operate on the objects 
represented by the selected lines of the report. If a selected line does not refer to an object (a 
header, for instance) the command is ignored.

The Instrument Schedule sorts the lights by location and number. The order of the positions 
is controlled by the Positions report. Each row of text that refers to a light can be double 
clicked to access that light's info. Similarly, Cut, Copy, Paste and Clear can be used to 
transfer information to and from selected light(s). Double clicking a header in the instrument 
schedule will bring up the inst. schd. setup, allowing you to customize the way lights are 
listed in the report.

The Channel List sorts the lights by channel. Lights with no channel are assumed to be 
unassigned and appear first in the report. Each row of text that refers to a light can be double 
clicked to access that light's info. Similarly, Cut, Copy, Paste and Clear can be used to 
transfer information to and from selected light(s). Double clicking a header in the channel list 
will bring up the chan. list setup, allowing you to customize the way lights are listed in the 
report.

The Circuit List (Hookup) sorts the lights by circuit. Lights with no circuit are assumed to be 
unassigned and appear first in the report. If MacLux Pro™ encounters a circuit assigned to 
more than one dimmer, it displays a patch error warning. Each row of text that refers to a 
light can be double clicked to access that light's info. Similarly, Cut, Copy, Paste and Clear 
can be used to transfer information to and from selected light(s). Double clicking a header in 
the circuit list will bring up the cir. list setup, allowing you to customize the way lights are 
listed in the report.

The Dimmer List (Hookup) sorts the lights by dimmer. Lights with no dimmer are assumed 
to be unassigned and appear first in the report. If MacLux Pro™ encounters a dimmer 
assigned to more than one channel, it displays a patch error warning. Each row of text that 
refers to a light can be double clicked to access that light's info. Similarly, Cut, Copy, Paste 
and Clear can be used to transfer information to and from selected light(s). Double clicking a 
header in the dimmer list will bring up the dim. list setup, allowing you to customize the way 
lights are listed in the report.
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The Hanging Schedule is a version of the Instrument Schedule which shows the instrument 
number and type of each light as well as its distance from the center or end of its position. 
(How the distance is measured is determined by the check box in the position's info labeled 
Layout From End.) A summary is shown for each position detailing how many of each type 
of light are needed. Each row of text that refers to a light can be double clicked to access that 
light's info. Similarly, Cut, Copy, Paste and Clear can be used to transfer information to and 
from selected light(s). Double clicking a header in the hanging schedule will bring up the 
hang. schd. setup, allowing you to customize the way lights are listed in the report. 

The Unused report lists either channels, circuits, or dimmers within a given range of numbers 
that have not been used in the plot. When you first open the unused report, a dialog will ask 
you for the range and which field before the report is generated. To change this, close the 
report window and select Unused from the windows menu again.

Color List displays the number and size of color frames required for each color used. This is 
first broken down by each hanging position. There is also a summary at the end of the report 
showing the total cuts needed for each color and size. The summary also shows the number of 
sheets needed as defined using the Frames command.

The Template List is very similar to the Color List except that it displays the number of 
templates needed for each position and a summary of the total number of templates used of 
each type.

The Equipment List shows how many of each type of light are being used. You can specify 
how many of each type you have by filling in the appropriate box in the Key.

The Magic Sheet lists the groups being used in the plot. Under each group heading is a list of 
the channel(s) associated with that group as well as the notes of individual lights. You can use 
the Optional Fields command to have the magic sheet display the focus field instead of the 
note field.

The Positions report lists hanging positions and determines the order in which they appear in 
other reports. The order of positions affects the Instrument Schedule, Color List and Hanging 
Schedule. Positions can be moved up and down the list by selecting the desired position(s) 
and using the + and - keys. Positions that have more than one segment should be grouped 
together by this method.

The Cue Sheet is a list of all the cues in the plot. It is available when you are in cue mode. 
Information for a cue may be accessed by double clicking on the row of text for that cue. 
Cues may be moved up and down the list by selecting the desired cue(s) and using the + and - 
keys.

Console Data contains Patch, Group and Cue data in the USITT standard format as specified 
by ASCII Text Representation For Lighting Console Data version 3.0. This standard is 
designed to promote the exchange of data between consoles of different manufacturers and 
PCs. More about the contents of the console data can be found on the next page.
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About Console Data 

Use the Save command to create a text file from this report. Then, various off-line editing 
programs for console will be able to read this file and convert it into the proprietary format 
used by the manufacturer. There are choices you can make about the contents of the console 
data set by the ASCII Options command.

The Patch data shows channel#<dimmer# or channel#<circuit# depending on the Report 
Setup (Dimmer box). The patch is non-proportional, @100 is added by default.

The Group data is included if the group field is checked in the report setup. It arranges the 
groups alphabetically like the magic sheet. Numbers are assigned in order, starting with 1. 
The Text label may not be displayed on all consoles. If it is not supported, it will be ignored 
by the receiving system. Groups are non-proportional in MacLux Pro™. So, levels are @100 
by default.

The Cue data includes channel levels, fade times, links and delays. EndData is required to tell 
the receiving system that the transfer is complete.

Raytrace Data is a description of a cue in the language used by a rendering program. 
MacLux Pro™ supports two text based rendering formats, the RenderMan Interface 
Bytestream (RIB) protocol and the style used by the Persistence Of Vision Ray Tracer . 
QuickDraw 3D format is also an option although it is not fully supported at this time. You 
may select the format of the raytrace data using the Report Setup command.

The RIB protocol was created by Pixar for its Academy Award winning RenderMan® 
software. (RenderMan is a registered trademark of Pixar). On the Macintosh, you can use RIB 
files created by MacLux Pro™ with Pixar's Showplace and MacRenderMan applications. The 
RIB format is also supported by a number of 3D modeling programs.

The Persistence of Vision Ray Tracer (POV-Ray) is a copyrighted freeware program that allows a user to 
easily create fantastic, three dimensional, photo-realistic images on just about any computer. POV-Ray reads 
standard ASCII text files that describe the shapes, colors, textures and lighting in a scene and mathematically 
simulates the rays of light moving through the scene to produce a photo-realistic image! —from the POV-
Ray Manual ©1992 by POV-Team

MacLux Pro™ is able to insert the lighting description into an existing scene file. When you 
first open the raytrace data window, MacLux Pro™ will prompt you to find the file in which 
to insert the lighting. For POV, the file should contain a comment line. "//macluxpro" 
which tells MacLux Pro™ where to insert the lighting information. ("#macluxpro" for RIB 
files) The raytrace data window will then contain a copy of the scene file with the current 
cue's lighting information inserted after the //macluxpro line. You can then Save the raytrace 
data window as a text file and render it using POV-Ray. If you choose cancel when asked for 
the file, MacLux Pro™ will generate a file which can be referenced by a scene file using an 
#include statement.

To align the lighting with the model, there are several things to keep in mind. For simplicity, 
1 unit in the model's frame is equal to 1 foot or 1 meter in the plot. The center point of the 
plot (at the floor plane) translates to <0 0 0> in the model's world. X coordinates are positive, 
stage left of center. Z coordinates are positive going upstage. If the actual floor in your model 
is at y= -2, you would set the plot's Floor Plane to 2.

See the tour section Using Raytrace Data for a step by step example using POV-Ray.

http://www.povray.org/binaries/index.html
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Cue Info... (cmd-I) allows editing of information about a cue including what, when and how 
fast. Double clicking on a cue in the Cue Sheet is the same as Cue Info. The current cue's info 
is also shown in the info bar. 

Items under Cue View can be replaced with the arrow keys. Next and Prev correspond to the 
right and left arrows. These commands will take you to the next or previous cue. Page Down 
and First Page correspond to the down and up arrows. These are used by the console if more 
channels are present than can be fit into a single display page.

Add Cue (cmd-D) creates a new cue following the current one and copies the current cue's 
levels. If the added cue is the last in the list, it will have a number one greater than the prior 
cue. Otherwise it will have the same number as the previous cue with “.” appended. When 
working with the Cue Sheet, the added cue will be placed after the selected cue.

New Cue (cmd-B) places a new cue with no levels (a blackout) after the current cue. If the 
new cue is the last in the list, it will have a number one greater than the prior cue. Otherwise 
it will have the same number as the previous cue with “.” appended. When working with the 
Cue Sheet, the new cue will be placed after the selected cue.

Move Up and Move Down move the current cue towards the top and bottom of the cue list 
respectively. You can also arrange the cues using the Cue Sheet. Select the cue or cues you 
want to move and use the + and - keys.

Film Cue allows you to create a group of PICT files which can be turned into a QuickTime 
movie of a cue. This is actually the transition from the current cue to the next cue. If you 
choose Film Cue when you are in the last cue, the command will do nothing. The animation 
can be of any view of the plot's main window or of the 3D model (if its window is visible). 
You may choose the number of frames per second. Then MacLux Pro will generate a PICT 
file for each frame of the movie. These may be assembled using QuickTime Player's Open 
Image Sequence command. Be sure to match the frames per second setting you used when 
you filmed the cue.

Import ASCII allows MacLux Pro™ to import cue, patch, or group data that has been stored 
in a text file. You can create cue data files by saving the Console Data report. When using 
Import ASCII, there are some important things to note: Manufacturer specific keywords are 
ignored. Clear is not supported. When reading cue data, Import ASCII creates new cues, 
starting at the current cue, rather than replacing any existing cue information.

ASCII Options lets you decide which types of data (patch, group or cue) you want to import 
and export via the Import ASCII command and the Console Data report. MacLux Pro™ lets 
you store all of your cue data in a separate text file by adding the $$What and $$When 
keywords to those defined by the USITT ASCII standard. ASCII Options lets you decide if 
you want to include this information in exported text. The USITT ASCII format permits only 
integer values for channels and dimmers. The "1a=1" option lets you strip repatch characters 
when exporting text for use with a console. MacLux Pro™ allows channel designations that 
are not integers (specifically for indicating repatches).
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Number Cues renumbers the cues starting from one. Links are updated automatically. 

A Note About Beams

MacLux Pro™ generally displays beams as ovals projected onto the floor plane. This model 
works well, except when displaying sidelight. So, to improve visualization of sidelight, 
MacLux Pro™ switches from representing the beam with an oval, to showing the beam as a 
wedge when the top edge of the beam rises above the floor plane

Because sidelight can travel forever without hitting the floor, MacLux Pro™ limits the wedge 
to 100 feet (meters).

When displaying sidelight in section view, MacLux Pro™ displays beams as wedges. 
However, sidelight beams are only displayed when they run perpendicular to the section. For 
instance, a beam crossing from stage left to stage right will only be displayed in the front 
section, not the side section.

If MacLux Pro™ cannot calculate a beam, it will draw a box around the light. This will 
happen any time the light is hanging at or below the floor plane.
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Extensions to the USITT ASCII Standard 

The USITT ASCII standard allows for manufacturer defined keywords. MacLux Pro™ 
defines and recognizes several keywords that extend the ASCII format and allow for 
automatic translation of cue data.

There are times when channel assignments change from venue to venue. The ASCII standard 
allows for portability of cue data. However, when channel assignments have to change, 
manual editing of the cue data becomes necessary. This is labor intensive (but possible as the 
file is a text file and can easily be edited). It just requires going through the cue data and 
replacing old channels with new ones. The keywords defined by MacLux Pro™, however, 
automate this task. What they do is instruct the program to substitute channel numbers as it 
reads the data. For example, it is possible to instruct MacLux Pro™ to replace channel 2 with 
channel 202 everywhere it appears in the cue data. This works very much like a channel to 
dimmer patch.

MacLux Pro™ creates a translation list of old channel to new channel entries. When it reads a 
channel@level as part of the cue data, it searches the list and looks for matches for the 
channel. When it finds one, it acts as if it had read the newchannel@level. The syntax is 
similar to the PATCH keyword:

$$PatchChan oldchan@newchan oldchan@newchan

The $$PatchChan keyword can appear anywhere in the data stream. A patch can even be 
modified once it is set. In practice, it works like this:

$$PatchChan 2@202 3@203 4@204

Cue 100

Chan 2@50 3@75 4@80

$$PatchChan 2@102 

Cue 101

Chan 2@50 3@50 4@30

Gets interpreted as follows:

cue 100 = 202 at 50, 203 at 75 and 204 at 80

cue 200 = 102 at 50, 203 at 50 and 204 at 30.            continued...
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The $$PatchChan keyword works well for moving a channels to another location. You can 
even condense channels by adding additional translations. For example if you had five areas 
across stage and are forced to reduce to three, you can set several inputs to a single output: 

$$PatchChan 11@101 12@101 13@102 14@103 15@103

Cue 10

Chan 11@50 12@40 13@30

Either channel 11 or channel 12 sets the level of 101. This is not perfect because the last 
channel encountered is the one whose level will used. The result of the above is that 101 is set 
at 40 and 102 is set at 30.

MacLux Pro™ defines a second keyword, $$PatchChans to also provide the ability to 
expand channels. For instance, maybe all the side blue was together and now you have 3 
seperate channels for it $$PatchChans allows a single input to cause multiple outputs. 
Where $$PatchChan allows you to override an existing patch, $$PatchChans always 
adds new translators to the list. Here's an example:

$$PatchChan 6@10 6@11 6@12

Cue 10

Chan 6 @50

Results in channel 12 @ 50. Where the following:

$$PatchChans 6@10 6@11 6@12

Cue 10

Chan 6 @50

Results in channel 10 at 50, channel 11 at 50 and channel 12 at 50.

The potential hazard of using $$PatchChans is that you are unable to alter the patch later 
in the data stream. Should you find this necessary, you will need to break the stream into 
seperate files, each with its own translation setup and import them individually.
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Keyboard Commands 

Chapter Contents

Selecting Tools

Accessing Light Info Fields

Selecting Symbol Directions 
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Selecting Tools Using the Keyboard 

MacLux Pro™ allows you to select tools using the keyboard. When working with the plot's 
main window, you can select tools using the D,F,G and H keys. These four keys are grouped 
together for easy access with the left hand.

Accessing Light Info Using the Keyboard

You can also use specific keys to access a light's fields, one at a time. This might be 
preferable to using the larger info dialog if you are repetitively editing the same field. For 
example, you might enter dimmer or circuit numbers consecutively for an entire hanging 
position. For casual editing, however, any speed advantage that the smaller dialog gives you 
will probably be wiped out because of the added time it takes you to remember which #$%! 
key to press.

Note: You can always hold down the control key and click on a light to pop up a menu of 
these fields!

When working with either the plot or paperwork, selecting a light and pressing the appropriate 
key, causes a dialog for editing the corresponding field to appear. For example, selecting a 
light and pressing “c” will let you edit the light's channel. The Put On Clipboard check box 
will copy the field to the clipboard when you click OK. It also sets the Paste Options to only 
that field. Thus, after entering a color using the quick edit shortcut, you can select several 
more lights and choose Paste Info which assigns that color to the other lights.

In addition, the numeric fields, channel, circuit and dimmer may be incremented and 
decremented by one using the “<“ and “>” keys. (Only those fields selected in the Paste 
Options will be affected.)
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Selecting The Direction of Light Symbols 

The direction a symbol will point when you place it on the plot using the Draw tool is selected 
with a combination of the shift and arrow keys (for keyboards without arrow keys use: n,s,e, 
and w).

The last key pressed determines the direction. Once a direction is selected, all symbols will be 
drawn pointing that direction until a new direction is chosen. (It is not necessary to hold the 
arrow key down as you draw.)

Holding down the shift key as you press the mouse button causes the symbol to rotate 45° 
clockwise. For example, first pushing the down arrow; then holding the shift key and pressing 
the mouse, will cause the symbol to point towards the lower left corner of the screen. (Once 
the cursor changes to a symbol, the shift key can be released.)

When a symbol or symbols are selected using the Arrow tool, choosing a new direction using 
the keyboard will change the direction of the selected symbol(s). For example, selecting some 
lights and pressing the up arrow will cause all of those lights to point towards the top of the 
screen.
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What's New in MacLux Pro™ v2.1 

MacLux Pro™ v2.1 has been re-written to be a "carbon" application. This means that it is 
able to run directly under OS-X without resorting to "classic" mode. There are many changes 
in the internal programming required to accomplish this. However, from a user's perspective, 
v2.1 is almost identical to v2.0.

If you are new to v2.0, you may wish to look at the list of the many changes from prior 
versions.

File Format / Printing

One of the new features of OS-X is a change in the way the operating system deals with 
printing. In order to store page setup and print job settings with the plot, the file format had to 
change. MacLux Pro™ v2.1 will open plots created with older versions. However, when it 
saves a plot, an older copy of MacLux Pro™ will no longer be able to open it.

Explore Color

In older versions of MacLux Pro™, the color picker you used was selected in the Preferences. 
In v2.1 the MacLux Picker has been improved and now has a seperate command called 
Explore Color. Explore Color searches the Color Library for named colors that match the 
color you see on screen.

Select After Drawing Preference

There is a new preference setting that causes MacLux Pro™ to have the same behavior as 
other programs where once a new object is drawn, it is immediately selected for editing.

Documentation of USITT ASCII keywords

MacLux Pro™ v2.0.1 introduced two keywords for automated translation of cue data. This is 
now documented. This allows cue data to be left intact while mapping channels when the cue 
is imported into MacLux Pro™.
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What's New in MacLux Pro™ v2.0 

Here are some highlights:

Power Mac Native!!

New look .

New Editable Lights Palette:  Symbol Browser--Flavor Popup.

Solid/Outline symbols can be individually selected.

Control-Click Popup Menus.

Auto-Fill Command for numbering things like channels.

New PICT objects which can be pasted into plot.  Replaces old Title and Key Blocks 
and includes Text .

Scroller Support.

Editable Lamp Library

Separate Section View window

N/C added to names list

Safe Save implemented.

New File Format.

Source Four Symbols Built-In.

Separate Page Setup for paperwork is saved with the plot.

Improved 3D Support

Improved Text Style Choices

Improved Console Syntax

Film Cue Creates Image Sequence / Sequence of Rendering Files

New OS features:  Appearance Stuff, Standard Alert, etc., Navigation Services 
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Power Mac Native 

MacLux Pro™ has been accelerated for Power Macintosh. This means that MacLux Pro™ 
runs much faster and its life has been extended well into the 21st century.

New Look

MacLux Pro™'s menus have been redesigned.  This was done for two reasons. First, the new 
editable lights palette was changed to be static rather than tear-off. This made more room 
available in the menu bar. Second, MacLux Pro™'s menus were originally designed for a 
Mac Plus screen, which resulted in a lot of congested sub-menus.

Because the palettes are no longer tear-off, they are shown and hidden from the Windows 
menu. To facilitate accessing the palettes, they have command keys, 1=Lights, 2=Tools. 
MacLux Pro™ remembers the palette's positions and if they are hidden or shown from the 
last time you used them.

With the new design, the PaperWork menu was eliminated and simply became a direct part of 
the Windows menu.  After you get used to it, you'll find it much easier to access reports. The 
Options menu was split up and became the Display, Controls, and Setup menus. The Display 
menu contains all the options related to how the plot is displayed, e.g. Zoom In/Out. The 
Controls menu contains other misc. options including Alignment and Fonts. The Setup menu 
gives access to overall information, including the libraries and report options.

New Editable Lights Palette:  Symbol Browser--Flavor Popup.

Each plot can now have its own palette of light symbols.  As before, Double-clicking or 
selecting the Key command brings up the main key information window for the selected 
symbol. In the Key info window, the Symbol button brings up the new symbol browser. You 
can select a new symbol for the palette by clicking on it and then the Choose button.
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Key improvements continued... 

You will notice that there are 5 pages of symbols, including one for importing of custom 
symbols. This means you can configure your palette from a choice of over 250 symbols. The 
more page leaves room for additional symbols to be built into MacLux Pro™ in the future.

You import symbols by selecting the Custom page in the symbol browser. Select a slot and 
click the Edit button. The custom symbol dialog is capable of switching between 
applications for easier copy and paste of symbols created by the user. It also has an Export 
button for creating symbol files that you can share with other users or import into other copies 
of MacLux Pro™.

Also new in the Key info window, is the "flavor" popup menu.  This allows you to specify the 
behavior of the symbol.  Most importantly this determines if the symbol is a light or just an 
accessory.  (The only symbol that is fixed is the circle accessory symbol)

Solid / Outline style symbols can be individually selected

Each individual symbol can be drawn using either a solid or outline symbol. You can choose 
solid or outline by clicking the Drawing button in a light's Info dialog. Or, you can use the 
Symbol Drawing menu commands found in the Selection menu.

Control-Click Popup Menus

Holding down the control key and clicking on lights and lines will bring up a menu that is 
equivalent to items found in the regular menus.  This can save lots of mouse movements, 
especially on larger monitors.  If more than one object is selected, the popup menu operates 
on all the selected objects.  You can also control-click on PICT objects.

Auto-Fill Command

The Auto-Fill command, found in the Selection menu, allows you to automatically enter a 
series of sequential numbers in the channel, circuit, dimmer, or unit number fields of selected 
lights. The numbering is done in the order the lights were selected. The introductory tour has 
an example of how auto-fill works.

New PICT Objects

MacLux Pro™ now includes the ability to put misc. graphic items onto the plot. These 
graphics are managed through a list window which is accessed by the PICT Objects 
command in the Edit menu.

PICT objects can be simple graphics which you paste into your plot. Or, you can enter a line 
of text and have it drawn on the plot. You can also automatically generate a title and key 
block.

When you convert a file to version 2.0, you will notice that the old title and key blocks 
become PICT Objects.
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Scroller Support 

MacLux Pro™ now includes support for color scrollers by linking scroller symbols to lights 
by ID.

Color scrolls are accessed by name and edited through the scroller symbol's key info window 
by clicking the Detail button.  Typically, all your scrollers will probably have identical 
color scrolls in them.  However, you can define as many scrolls as you want.  A scroll 
consists of a list of colors and levels which you create in the scroll editing window.  A 
scroller current color is determined by the matching the highest level in the list that is equal to 
or less than the level of its channel.

A symbol with the flavor "scroller" has an ID and scroll name in addition to channel, cir, etc. 
A light with a matching ID in its color field will be have its symbol color determined by the 
level of the scroller's control channel. For example, if a scroller symbol has the ID "c/c1" and 
is assigned to channel "115" any light with the color "c/c1" will have its symbol color 
determined by the level of channel 115 and, of course, the colors in the scroller color scroll.

You can set the level of a scroller channel using the console. Or, when you click on a scroller 
using the hand tool, a popup menu of colors appears.

Lamp Library

The lamp library that allows MacLux Pro™) to decode FEL into 1000 watts is now accessible 
and editable.  Like the other libraries, it is found in the Setup menu and selected using the 
Lamps command.

New Section View Window

Section View has been separated from the main plot and is now displayed in its own window.

N/C Added to Names List

MacLux Pro™'s drawing options for light information include the ability to automatically 
skip putting the designation "N/C" on the plot.  The Names command (under Setup) now 
allows you to change this feature from detecting "N/C" to "O/W" or whatever you wish.

Safe Save

When you save a plot with MacLux Pro™ version 2.0, the program first writes your changes 
to disk as a new file.  Then it erases the old copy of your plot and replaces it with the new 
one.  This way, if anything should go wrong during the operation (the power goes out, the 
Mac crashes...) you will still have the last revision you saved intact on the disk. This does not 
reduce the need for the standard practice (for all software, not just MacLux Pro™) of saving 
your work often!
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New File Format 

In order to accommodate may of these new features, MacLux Pro™'s file format was 
expanded and streamlined.  One of the results of this effort is that files open much faster.  
This also means that you will not be able to open plots created with version 2.0 using older 
copies of MacLux Pro™.

Source Four Symbols

Standard symbols for Source Four and Source Four PAR instruments are now built into 
MacLux Pro™. They can be found on the More symbols page of the symbol browser.

Separate Page Setup for Paperwork is Saved with the Plot.

MacLux Pro™ now saves a separate page setup for paperwork. This means that you no longer 
have to go to the Page Setup command every time you switch from printing the plot to 
printing paperwork.

Improved 3D Support

The Raytrace Data report now allows you to merge the lighting with an existing scene file.  
This can save the extra step of copying and pasting. With this method, when you save the 
Raytrace Data window, the resulting file is ready to be rendered. Opening the Raytrace Data 
window, causes MacLux Pro™ to prompt you for a scene file. Clicking Cancel will cause 
MacLux Pro™ to list only the lighting data as with earlier versions. MacLux Pro™ looks 
through the specified scene file for a comment line and inserts the lighting data at that point. 
The resulting combination is displayed in the Raytrace Data window and can be saved for 
rendering.

MacLux Pro™ chooses where to insert the lighting by looking for a specific line in the scene 
file.  RIB files should contain the line "#macluxpro".  POV and 3DMF files should contain 
the line "//macluxpro"

Raytrace Data also now has the option of being expressed in 3DMF format in addition to 
POV and RIB.  (selected as before through the Report Setup dialog) This is still a bit 
experimental as far as getting the scale of the lighting to match the model.

Improved Text Style Choices

Text styles and now selected using a standard popup menu rather than being limited to bold, 
italic and extended.

Improved Console Syntax

MacLux Pro™'s Console will now accept more extensive commands (the syntax is more 
flexible).
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Film Cue Creates Image Sequence / Sequence of Rendering Files 

QuickTime Pro allows you to convert a sequence of image files into a movie. The Film Cue 
command now produces a series of image files rather than a scrapbook file in order to support 
this change. When used with the Raytrace Data window, Film Cue will produce a sequence of 
files that can be batch rendered using POV-Ray. The resulting images can be assembled into 
a movie using QuickTime Pro, resulting in a full 3D movie of a cue.

New OS Features

MacLux Pro™ now takes advantage of new Mac OS features including Navigation services 
and Appearance features. You'll probably notice the change in the Open and Save dialogs.

http://www.apple.com/quicktime/
http://www.povray.org/binaries/index.html
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